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Chapter 1 
Introduction

This chapter contains a general introduction to the Océ 
TDS320. This chapter describes the main features, the 
options and the software applications provided with the 
system.
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The Océ TDS320

The Océ TDS320 is a wide format, black and white, multifunctional system. 
The Océ TDS320 offers a broad range of print, copy, and scan-to-file 
functionality. The system includes a printer (1 or 2 rolls), a controller and an 
optional scanner. 

[1] Océ TDS320
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The Océ TDS320 concept and components

The Océ TDS320 printer

The Océ TDS320 printer is available with an automatic 1- or 2-roll unit and 
manual feed. Use manual feed when you want to print a job on a media type or 
size that is not available on one of the paper rolls. 

Note: The manual feed is a special slot just above the paper drawers on the 
printer. You can insert cut sheet material in this slot, one sheet at a time. Refer 
to ‘Copy on pre-cut sheets’ on page 51 on how to copy on pre-cut sheets.

Note: Only use material as specified in ‘List of available material types and 
sizes’ on page 139.

The Océ TDS320 is a 600 DPI LED printer with a print speed of 1.8 A0 or 3 
meters per minute. 

You can perform a number of activities at the Océ TDS320 printer. You can set 
the media type and size, stop a print job or select your preferred language from 
the printer operator panel (see chapter 2, ‘Use the Océ TDS320 to print’ on 
page 17 for more details). 

The Océ TDS320 is delivered with drivers and job submission software to 
enable you to print from AutoCAD®, Windows® or Macintosh® applications.

The Océ TDS320 scanner

The Océ TDS320 scanner supports a wide range of copy activities. It provides 
a large number of functions for defining original and copy related settings. You 
can specify particular media, feeding and quality enhancement options from 
the scanner operator panel. In combination with the Océ TDS320 printer it 
forms a powerful productivity tool. 

The scanner scans your originals. You can print the originals (copy job) or you 
can store the scanned original in a file (Océ Scan Logic®). The scanner has 
different quality modes which are provided by Océ Image Logic®.
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■ Green key principle
The Océ TDS320 is easy to use. Press the green key on the scanner operator 
panel to start the basic copy jobs. If you have difficult copy jobs, you change 
the default copy settings with the help of the other settings on the scanner 
operator panel.

The Océ Power Logic® controller

The Océ TDS320 is equipped with a controller to process the print jobs and the 
copy jobs. The controller can have Océ Remote Logic® to make your default 
printer settings.

The Océ Power Logic® controller  processes the print jobs and the copy jobs. It 
also processes the optional scan to file jobs. 

■ Set processing
When you send a file to the printer, the file is processed once and can be printed 
many times. The Océ TDS320 has a set memory to store a maximum of 1000 
A0s which allows you to create the same sets that are sorted either by page or 
by set.

■ Spool memory
The Océ TDS320 has a spool memory which provides a queuing system for 
files you want to print. The spool memory allows many users to send the print 
jobs to the Océ TDS320 at the same time. The print jobs are put in the print 
queue where they wait to be printed. The job that is put first into the queue is 
printed first.

■ Network connectivity
The Océ TDS320 controls a number of common network protocols. The Océ 
TDS320 can be used in many networks like TCP/IP and Novell®.

■ Security
You can increase the security level of the Océ Power Logic® Controller from 
Standard to Medium or High. The security levels Medium and High are meant 
for organizations with special security requirements. For example 
governmental organizations, and organizations in the defense or the aerospace 
industry.
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Attention: When you increase the security level to Medium or High, some of 
the functions of the system cannot operate. When the security level is set to 
Standard, all Océ Power Logic® features are available.

When you increase the security level to Medium, the following features are not 
available.

■ Scan to file to remote destinations
■ Océ Remote Logic®

■ Printing through Novell Pserver
■ Various network connectivity protocols.

When you increase the security level to High, the following features are not 
available.

■ Scan to file to remote destinations
■ Océ Remote Logic®

■ Printing through FTP (File Transfer Protocol)
■ Printing through Novell Pserver
■ Various network connectivity protocols.

Note: Please contact your local Océ Service organization for complete 
information.

Océ Remote Logic®  enables you to connect to the Océ Power Logic® 
Controller from a remote workstation.

Océ Settings Editor  The Océ Settings Editor allows you to set the default 
settings of the Océ TDS320 according to your companies requirements.

Refer to ‘Océ Power Logic®: The Settings Editor’ on page 95, for complete 
information about the Océ Settings Editor application.

Océ TDS320 options

By default, the Océ TDS320 has an automatic 1 roll unit and is equipped with 
a receiving tray as the output delivery device. The receiving tray is the rack on 
the bottom of the printer (see figure 1 on page 12).

Automatic 2-roll unit  The Océ TDS320 is available with an automatic 2-roll 
unit. Each of the rolls can be loaded with print material of a different size or 
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type. The size and type of the available media are indicated on the operating 
panel.

Compact Output Stacker  The optional compact output stacker offers a smart 
and efficient disposition of printed or copied drawings (up to 100 prints) on 
PPC material and some other materials. 

Graphical User Interface  The Graphical User Interface (GUI) consists of a 
screen, a mouse, a keyboard and software. You use the screen, mouse and 
keyboard to interact with the graphical user interface of the controller. With the 
GUI you can perform Key Operator and System Administrator tasks in a 
graphical way. Settings are visible within one window so that it is much easier 
to view and change them.

Océ Scan Logic®  Enables you to scan a document to file for later (re)use. You 
can use the files in other applications or print them out.

■ Océ Scan Manager with Océ View Station LT
The Océ Scan Manager is an application available only locally on the 
controller. With the Océ Scan Manager you can: 
■ configure the destinations for scan-to-file jobs
■ increase your productivity with automatic file naming
■ view the scans

Refer to ‘Use the Océ TDS320 to Scan to file’ on page 59 for complete 
information about the Scan Manager application.

Adobe® PostScript® 3/PDF  The Océ TDS400 fully supports Adobe® 
PostScript® 3. For Japanese 5 extra fonts are optional. They can be enabled 
with a password in the Océ Settings Editor.

Océ Print ExecTM LT  Océ Print ExecTM LT is optional software to create and 
submit your print jobs.
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Océ TDS320 users

The Océ TDS320 has the following user types:

System administrator  The Océ TDS320 system administrator installs and 
makes the configuration for Océ TDS320. The system administrator defines 
the printer-language settings, pen settings and Automatic Language Sensing 
(ALS) settings. The system administrator can help the users who need to install 
the printer drivers on their workstations. See chapter 7, ‘Printer supplies and 
maintenance’ on page 109 for complete information. The configuration 
information is in the Océ TDS320 Connectivity Manual provided with the Océ 
TDS320.

Key operator  The Océ TDS320 key operator is responsible for the daily 
maintenance of the Océ TDS320. The key operator replenishes toner when 
necessary, loads media as needed and defines the default printer settings for 
recurring print jobs. Also, the key operator defines all time settings, such as 
panel time out and sleep mode time out. 

Repro operator  The repro operator is responsible for the daily operations on 
the Océ TDS320. The Repro Operator settings are a subset of the Key Operator 
settings. The Repro Operator has no rights to change settings in the Océ Settings 
Editor. 

Anonymous user  Typically, an anonymous user on the Océ TDS320 can be 
either a PC user who has remote access to the system through one or more 
drivers (Océ Windows® Printer driver, AutoCAD® HDI or PostScript®) or the 
remote applications (Océ Settings Editor), or the print submission/print 
management applications, or a user performing a copy job at the scanner.

Service operator  The Océ TDS320 service operator is responsible for 
installation and maintenance of the Océ TDS320. 

User interaction

You can operate the Océ TDS320 from different locations: local and remote:
■ Operator panels 

The Océ TDS320 has two operator panels to make the settings for the print 



14 Océ TDS320 User Manual

jobs and the copy jobs. See ‘Printer operator panel’ on page 18 and ‘Scanner 
operator panel’ on page 38 for complete information.

■ Océ Remote Logic® 
Use the Océ Remote Logic® to make the default key operator and system 
administrator settings (Océ Settings Editor). 

■ Océ Scan Logic® 
With Océ Scan Manager and Océ View Station LT you can define all 
important settings for scanning. 

■ Printer drivers 
With the Océ TDS320 one or more printer drivers can be used, including Océ 
Windows® Printer driver, AutoCAD® HDI and PostScript®. With these 
drivers PC users can access the Océ TDS320 remotely, from their 
applications, to print their files. More information about installing, 
configuring and use of the drivers can be found in the documentation 
provided with the drivers. All Océ drivers (except Postscript) can be freely 
downloaded from the Web at www.oce.com.
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The data flow to the Océ TDS320 

Connect the Océ TDS320 to a workstation connected to a network. It accepts 
different standard format vector and raster data files from the host environment 
and converts these into high quality prints (see figure 2).

[2] Data flow to the Océ TDS320

When an Océ TDS320 receives vector, raster, Adobe® PostScript® or PDF 
(optional, Adobe® PostScript® 3™) data it will generate a print with the 
settings as specified in the Océ Settings Editor.

Each print job has remote control commands to indicate the settings for a job. 
This so-called header contains the job and the file defined settings in Océ Job 
Ticket (OJT). The OJT settings overwrite the settings defined in the Océ 
Settings Editor. Except for pen settings and job management which have 
priority over the Océ Job Ticket settings.

Application
Software

Océ TDS320

Printfile 
Print

Job
Settings

Print
File



16 Océ TDS320 User Manual

To compose such a header, you can:
■ Compose the header within your application. Please refer to the Océ Job 

Ticket (OJT) manual.
■ Use an Windows® and/or AutoCAD® HDI driver to generate both a 

printable file (e.g. HP-RTL, HP-GL/2) and the appropriate header with 
RCF-commands. Please refer to the Windows® / AutoCAD® Driver 
documentation.

■ Use the Océ job submission software like Océ Print ExecTM LT to compose 
jobs of printable files in a flexible and user friendly way. Please consult the 
on-line help on the Océ Print ExecTM LT application for detailed 
information.



17

Océ TDS320

User Manual

Chapter 2 
Use the Océ TDS320 to print

This chapter explains how to print with the Océ TDS320.



18 Océ TDS320 User Manual

Printer operator panel

The operator panel on the right hand side is easy to use (see figure 3). The 
panel has keys and a display.

[3] Printer operator panel

next/select

previous

on-line stop
Stop key

On-line 
key

Browse  
keys

Next/select 
key

Previous
key

Alphanumeric display
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Display

The display shows the feedback about print job status and error messages see 
page 33 and page 34 in normal mode. In off-line mode it shows the ‘off-line’ 
menu (see figure  on page 36).

Menu level indicator

The menu level indicator indicates the current position in the menu. Press the 
Previous key to scroll through the menu.

[4] Menu level indicator in the top level of the menu
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Keys

With the keys on the operator panel you can make the settings for the Océ 
TDS320 Printer.

The following keys are available

 

Available keys
Key types Function
On-line key Press the On-line key to put the printer on-line or off-line. To ac-

tivate the program mode and to enter the top level menu. You 
can use the Next/select key, the Previous key and the Browse 
key to go through the menu. If the green light above the On-line 
key is on, the printer is on-line; if this light is off, the printer is 
off-line.

Next/select key To select an option or a setting in the menu. Or in case a 
sub-menu is present, enter a menu on a lower level.

Previous key Press this key to go one level higher in the menu.
Browse keys These two keys are used to select another mode at the same level 

of the menu, or to display the next or previous option from the 
option list.

Stop key The red Stop key is used to stop the current print job. 
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How to turn on and turn off the Océ 
TDS320 printer

To turn on the system:
■ turn on the printer. 
■ turn on the scanner (see page 43).
■ turn on the controller(see page 22).

When you turn on the system, it is ready for operation. In this state, the 
machine is in the stand-by mode.

If the system is not in use for more than 1 minute, the operator panel returns 
automatically to the stand-by mode. The operator panel of the scanner is 
activated in the following conditions:
■ you feed an original
■ a key on the operator panel is pressed

▼ Turn on the printer

1 Set the ON/OFF switch at the rear of the printer to position ‘1’ (see figure 5). 
If the power supply is connected, the green switch lights.

[5] On/off switch of the printer

Note: When ‘Ready’ is displayed on the operator panel, the printer is ready for 
use.
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▼ Turn off the printer

1 Set the ON/OFF switch at the rear of the printer to position ‘0’ (see figure 3).

Attention: If you switch off the printer during a print job, it is possible that 
you lose information or that a paper jam occurs.

▼ Turn on or off the controller

1 Press the key on the front of the controller to turn the controller on or off.

Cancel a print

Cancel a print before you start the print or during the print.

▼ Cancel a print

1 Press the Stop key.
The printer stops. 
When the printer runs, the paper is cut.
The paper is always ejected.
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Menu structure

On the Océ TDS320 printer operator panel, you can do a number of actions. 
These actions include: 
■ Media settings (material and size).
■ Print info (configuration report, menu card and demo print).
■ Configuration (connectivity issues).
■ System (clear set memory and diagnostic mode).

Media type and size on the printer

One of the features of the Océ TDS320 printer is the automatic media change 
function. This function allows the printer to take another roll of the same 
format and copy material when the roll becomes empty when you print. You 
must configure this setting in the Océ Settings Editor (see ‘Océ Power Logic®: 
The Settings Editor’ on page 95). 

If you activate this function the machine automatically switches to the other 
roll, if the used one becomes empty. The switch only occurs if the kind of 
media and the width of the material is the same for both rolls.

Note: The Océ TDS320 Printer cannot identify the copy material type and 
format. Fill the media and indicate the type and the size as described in 
chapter , ‘Media’ on page 110.

See ‘List of available material types and sizes’ on page 139 for a summary of 
all materials for the use with the Océ TDS320 Printer.

If you insert a new roll with another material or with a different width, you 
have to program the new roll specifications. Refer to ‘List of available material 
types and sizes’ on page 139.

Note: The machines switches automatically to the other roll if the used roll 
becomes empty, if you activate this function in the Océ Settings Editor. 
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▼ Set the media width settings

1 Press the On-line key to put the printer off-line.
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’or ‘Roll 2’ with the  or  key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Width’ item with the  or  key.
7 Press Next/select to enter the ‘Width’ menu.
8 Select the desired width with the  or  key.
9 Press Next/select to confirm the selected width.

10 Press On-line to put the printer on-line again.

▼ Set the media type settings

1 Press the On-line key to put the printer off-line. 
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’, ‘Roll 2’, ‘Manual feed’ with the  or  key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Material’ item with the  or  key.
7 Press Next/select to enter the ‘Material’ menu.
8 Select the desired media material with the  or  key.
9 Press Next/select to confirm the selected media material.

10 Press On-line to put the printer on-line again.
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Manual feed

There are two possibilities to select manual feed:
■ via remote control commands added to the print file (by means of drivers).
■ choose ‘manual feed’ on the scanner operator panel.

[6] Manual feed

If you want to use manual feed, you must:
1 program the media settings (material and feed time out) on the printer
2 send the file
3 feed the sheet of material
4 hold the material until the printer pulls in the first part of the material.

If you select manual feed, the printer will inform you to feed the sheet into the 
printer. There is a time out between 1 and 10 minutes. Default is 1 minute. 

▼ Set the time-out for manual feed

Default is 1 minute.

1 Press On-line to put the printer off-line.
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Manual feed’ with the  or  key.
5 Press Next/select to enter the ‘Manual feed’ menu.
6 Select the ‘Time out’ with the  or  key. 
7 Press Next/select to enter the ‘Time out’ menu.
8 Select the desired time out with the  or  key.
9 Press Next/select to confirm the selected time-out.

10 Press On-line to put the printer on-line again.
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Cut media

If the material does not have a straight leading strip, you can cut the material 
at right angles from the roll.

▼ Cut the material from roll 1 or roll 2

1 Open the drawer.
2 Feed the paper manually until it is 5 cm above the top drawer.
3 Press the On-line key to put the printer off-line.
4 Close the paper drawer.
5 Select the ‘Media settings’ item with the  or  key.
6 Press Next/select to enter the ‘Media settings’ menu.
7 Select ‘Cut media’ with the  or  key.
8 Press Next/select to cut the paper.
9 Open the paper drawer.

10 Remove the scrap of material.
11 Feed the material until you can see the material and put the material into 

position (see figure 46 on page 113) and (see figure 50 on page 115).
12 Close the drawer.
13 Press the On-line key to put the printer on-line again.
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Print info

You have the possibility to print:
■ the configuration report
■ the menu card
■ a demo plot

Print the configuration report

The configuration report shows the configuration and the settings of the 
system.

▼ How to print the configuration report

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Configuration’ item with the  or  key.
5 Press Next/select to print the configuration report.
6 Press On-line to put the printer on-line again to print the report. 

Print the menu card

You can print the menu of the printer, to guide you through the menu.

▼ How to print the menu card

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Menu card’ item with the  or  key.
5 Press Next/select to print the menu chart.
6 Press On-line to put the printer on-line again to print the menu card.
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Print the demo print

After the installation of the Océ TDS320, you can print the demo print, to 
check the printer and the controller.

▼ Make a demo print

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Demo print’ item with the  or  key.
5 Press Next/select to print the demo print.
6 Press On-line to put the printer on-line again to print the demo print.
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Configuration

Select a language

On the operator panel of the Océ TDS320 Printer you can indicate which 
language you use to display the printer information, like status and error 
messages.

▼ Select a language

1 Press the On-line key to put the printer off-line. 
2 Select the ‘Configuration’ item with the  or  key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Language’ with the  or  key.
5 Press Next/select to enter the ‘Language’ menu.
6 Select the desired language with the  or  key.
7 Press Next/select to confirm the selected language.
8 Press On-line to put the printer on-line again.
9 Turn the printer ‘off’ and ‘on’ again.

Network settings

The Océ TDS320 has 2 network adapters. To set the network settings you must 
enter the network data in 4 fields.
■ Use DHCP server. The Dynamic Host Configuration Protocol (DHCP) is a  

protocol to a u tom a te the a ssig nm ent of Internet Protocol ( IP) addresses in a  
netw ork . W ithou t DHCP, the IP address m u st be entered m anu ally.

■ IP address. An IP address has two parts: one part identifies the network (with 
the network number) and the other part identifies the specific machine or host 
within the network (with the host number).

■ Subnetmask. A subnet (short for ‘subnet work’) is an identifiably separate 
part of an organization's network. To manage routing that could and should 
be handled within an organization. 

■ Set default gateway A g atew ay is a  netw ork  point that acts a s an entrance to 
another netw ork . 

Enter the following ‘password’ (key sequence) to get access to the System 
menu on the printer to set the network settings.
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▼ Enter the System menu

1 Press arrow left ( ).
2 Press the Stop key.
3 Press arrow right ( ).
4 Press the Stop key.
5 Press arrow left ( ).
6 You can now enter the System menu.

▼ Set use DHCP server

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Select ‘Network sett.’ with the  or  key.
5 Enter the ‘password’ (key sequence) to get access to the ‘System’ menu.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Use DHCP server.’ with the  or  key.

10 Select ‘Yes’ or ‘No’ with the  or  key.
11 Press Next/select to confirm.
12 Press On-line to put the printer on-line again.

▼ Set the IP address

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the ‘password’ (key sequence) to get access to the ‘System’ menu.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘IP address’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘IP address’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘IP address’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘IP address’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘IP address’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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▼ Set the Subnetmask

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the ‘password’ (key sequence) to get access to the ‘System’ menu.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Subnetmask’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘Subnetmask’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Subnetmask’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Subnetmask’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Subnetmask’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.

▼ To set the Default gateway

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the ‘password’ (key sequence) to get access to the ‘System’ menu.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Default gateway’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘Default gateway’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Default gateway’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Default gateway’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Default gateway’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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Paper series

You must enter the paper series that you use in the printer. Choose between:
■ DIN
■ DIN CARTO
■ Only 8.5 inch
■ Mix 8.5/9 inch

▼ To set a paper series

1 Press the On-line key to put the printer off-line.
2 Select the ‘Configuration’ item with the  or  key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Paper series’ with the  or  key.
5 Press Next/select to enter the ‘Paper series’ menu.
6 Select the required paper series with the  or  key.
7 Press Next/select to confirm.
8 Press On-line to put the printer on-line again.

Clear set memory

The set memory indicates the available memory. If an error occurs, for example 
the set memory reaches its limits, you must clear the set memory.

▼ Clear set memory

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the ‘password’ (key sequence) to get access to the ‘System’ menu.
5 Select the ‘Clear setmem’ item with the  or  key.
6 Press Next/select to enter the ‘Clear setmem’ menu.
7 Select ‘Yes’ or ‘No’ with the  or  key.
8 Press Next/select to confirm the setting.
9 Press On-line to put the printer on-line again.

10 Turn ‘off’ and ‘on’ the controller.

Diagnostic mode

The Diagnostic mode is only meant for the Océ service technician.
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Status messages

Status Messages 
Status messages Explanation
Off-line The printer is off-line.

Change options.
Reset printer Turn the printer off and turn the printer on.
Connecting..... There is no communication between the controller and the printer.

Wait until there is communication.
Printer asleep The printer is in low power mode. 

The energy is saved.
Please wait The printer downloads the language.

Wait until the printer is prepared to operate.
Printer ready The printer is prepared to print.
Preparing job The printer prepares a print or copy job.
Printing The printer prints.
Load roll 1
A2
Paper

The printer detects that the required media is not available on roll 
1.
Fill roll 1 with the indicated media.

Load roll 2
A2
Paper

The printer detects that the required media is not available on roll 
2.
Fill roll 2 with the indicated media.

Manual feed
A2
Paper

The printer detects that the required media is not available in the 
manual feed.
Put the required media in the manual feed.

Open left cover
Refill toner
Press <on-line>

The toner container is empty.
Refill the toner container.

Conditioning The machine improves the print quality by optimizing the  
toner concentration.
Wait until the toner concentration is at the correct level.

Printer ready
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1.

Printer ready
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2.

Printer running
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1 after the printers stops printing.

Printer running
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2 after the printers stops printing.

Job canceled The current print or copy job is canceled
Close roll unit The roll unit is open.

Close the roll unit.
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Error messages

Sensor not free
Remove paper
Press <on-line>

The paper of one of the rolls is transferred after the marker (see 
‘Feed the material’ on page 113) when power is applied to the 
printer.
Take the paper back.
Press <on-line>

Paper retracted
Press <on-line>

Put the paper into the manual feed.
Press <on-line>

Copy too short
Remove paper
Press <on-line>

The length of the print material is less than 420 mm. This can oc-
cur with the manual feed.
Use an original longer than 420 mm.

Inputflap open
Close inputflap

The input flap is open.
Close the input flap.

Inputflap open
Remove paper
Press <on-line>

The input flap is open during the print process
Remove the paper and press <on-line>.

Roll 1 empty
Open roll unit

The paper on roll 1 is empty.
Open the roll unit and replace it.

Roll 2 empty
Open roll unit

The paper on roll 2 is empty.
Open the roll unit and replace it.

Error messages 
Error messages Explanation
Copy too late
Remove paper
Press <on-line>

The copy is too late at the paperpath output sensor
Remove the print material.

Speed failure
Remove paper
Press <on-line>

A paper jam occurred.
Remove the paper jam and press <on-line>

Knife 1 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Knife 2 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Roll retract err
Press <on-line>

Print material error when the roll unit takes back the material.

Status Messages (continued)
Status messages Explanation
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Roll unit error
Open roll unit
Press <on-line>

A sensor of the roll unit is activated when power is applied to the 
printer.
Open the roll unit.
Guide the paper to the marker (see ‘Feed the material’ on 
page 113.
Press <on-line>

Input too late
Open roll unit
Press <on-line>

The input sheet is too late.
Open the roll unit
If necessary, withdraw roll and rewind
Press <on-line>

Deposit error
Press <on-line>

An error in the compact output stacker occurred.
The compact output stacker stops.
The print process continues.
Press <on-line>.

Illegal language on 
controller
using UK English
Press <on-line>

The controller has an illegal language.
The controller uses the English language instead of the selected 
language.
Call service.
Press <on-line>

Close roll unit
Rewind paper
Press <on-line>

While you printed, the roll unit opened.
Rewind the paper.
Close the roll unit.
Press <on-line>

Error messages (continued)
Error messages Explanation
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Menu structure of the printer

When you browse through the tree, the left items are displayed on top. The 
upper items are displayed first.

A0 (841x1189mm) 
A1 (594x841mm) 

A2 (420x594mm) 
A3 (297x420mm) 

B1+ (707x1000mm) 
B2+ (500x707mm) 

B1 (700x1000mm) 
Width B2 (500x700mm) 

E (34x44”) 

D (22x34”) 
C (17x22”) 

 

B (11x17”) 

Roll 1 

E+ (36x48”) 
D+ (24x36”) 

 

C+ (18x24”) 

Roll 2 

B+ (12x18”) 
30x42” 

 

 

Media settings 
Paper 16lb

 Paper 20lb
 

Transparent 20lb 
oz 

Transparent 20lb 
oz 

Material Transparent 28lb 
oz 

 Vellum 
Material Film 3.5 

Film 4.5 
Manual feed Translucent 

 
Timeout 67 seconds 

 
Cut media Cutting... 

Configuration Printing... 
  

Print info Menu card Printing... 
  

Demo print Printing... 

US English 
Language Nederlands 

more... 
Configuration  

DIN 
Paper series DIN CARTO 

 ONLY 8.5” 
MIX 8.5/9” 

Clear setmem Yes 
  No 

System Enter password   
Diagnostic 

mode 
Yes 

No 
  

Use DHCP 
server 

Yes 

 No 
  

Network sett. adapter 1 IP address 123.456.789.123 
  

Subnetmask 123.456.789.123 
  

Default 
gateway 

123.456.789.123 

  
Use DHCP 
server 

Yes 

 No 
  

adapter 2 IP address 123.456.789.123 
  

Subnetmask 123.456.789.123 
  

Default 
gateway 

123.456.789.123 

Installation Enter password start install. 

Stacker
Delivery First Fold

Belt

TrailingLegend
Leading

Input

Standard
Method Afnor

Ericsson

Off
Binding On

Reinforce

Binding edge (15 .. 30)

Package Length (276..310)
Width (186..230)

Clean RU knife Cleaning RU...

Folding

Paper 28lb
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Chapter 3 
Use the Océ TDS320 to copy

This chapter contains a description how to copy with the 
Océ TDS320.
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Scanner operator panel

Make the settings with the scanner operator panel. The display gives you the 
feedback and the available menu options.

.

[7] Scanner operator panel

+-start cancel

stripexposure

input output extra

set file

zoom

sheet copy

leading

trailing

roll 1

roll 2

manual

media

Input key Extra keyOutput 
key

Alphanumeric 
display

Browse keys

Confirm
key

Strip key

Copy quantity 
display

Cancel key

+ key

Zoom key

Exposure 
key

- key

Start key

Media key
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The keys
The Input key  Select a single original or a set originals.

The Output key  Select copy or file (scan-to-file) as your output.

The Extra key  This key allows you to enter the Extra mode of the scanner and 
return to the normal mode. Set the properties for the original, the scanned files 
and for the scanner in the Extra mode.

The Browse keys (left , right )  Move in one level of the menu structure as 
the display shows. Browse the preset zoom values.

The Browse keys (up , down )  Move between the levels of the menu 
structure as the display shows. Adjust the zoom value with an accuracy of 1 
percent.

The Confirm key  Confirm the current setting in the menu structure. If you 
press the confirm key a second time in the current menu item, you restore the 
previous setting.

The Strip key  Press this key to add or to remove a ‘leading’ or a ‘trailing’ strip. 
The icon flashes. Use the browse keys (left , right , up , down ) to change 
the value. The icon remains on if you press another settings key and select a 
different value than the default value.

The Cancel key  Press this key one time to set the copy counter to the default 
value. Press this key twice to change all settings to their default values. The 
scan stops if you press this key.

The - and + keys  Change the number of copies.

The Start key   Press the green start key  to start the scan or to restart the 
copy process.

The Zoom key  Enters the zoom mode. The icon flashes. Use the browse keys 
(left , right ) to browse the preset zoom values. Use the browse keys (up , 
down ) to adjust the zoom value with an accuracy of 1 percent.

The Exposure key  enters the exposure mode. The icon flashes. Use the browse 
keys to change the exposure value.

The Media key  Select roll 1, roll 2 or manual feed. The equivalent icon is on.
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The display

The display shows the feedback about the scan job status (see table below) in 
normal mode. In off-line mode it shows the off-line menu (see page 58) and 
(see page 66))

.

Status messages 
Status Messages Explanation
Scanner ready The scanner is prepared to scan.

 +  = add
             = close

Add an original to the set and press the Start key .
After the last scan of the set, remove the original and press 
the Start key  to close the set.

Connecting..... There is no communication between the controller and the 
scanner.
Wait until the there is communication.

Scanner asleep The scanner is in low power mode.
Scanner running The scanner scans.
Please wait The scanner downloads the languages.
Remove original
Press <cancel>

There is an original on the table while you turn on the scan-
ner.
The message appears if you pressed the Cancel key while 
you scan.
Remove the original.
Press cancel.

Original too long
Press <cancel>

Use an original shorter than 15 meters.

Wrong orig. type
Press <cancel>

This message shows when you select ‘Background compen-
sation’ and ‘Blueprint’ as original.
Press cancel.

Set closed You closed the copy set.
Reset scanner Turn the scanner on and off.
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Menu level indicator

The menu level indicator indicates the current position in the menu. Press the 
Previous key to scroll through the menu.

[8] Menu level indicator on the scanner operator panel

input output extra

set file

sheet copy
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Copy jobs

Your printer system has a 1 roll or 2 roll unit. Use the Media key, on the scanner 
operator panel, to select a roll, or to select the manual feed on the printer. 

Note: You must set the media type on the printer. 

You can make 1:1 copies and you can decrease or increase your original from 
25% to 400%. You can set the zoom value in fixed steps or in % steps. The 
default zoom is set in the Océ Settings Editor.

The Océ TDS320 cuts the paper to the length of the original, the synchro cut. 
If you select the standard cut mode, the copy is cut at a standard length, (see 
‘Set synchro or standard cut’ on page 54).

The automatic exposure gives background-free copies from most 
line-drawings. Select the correct original type if you have an extremely dark or 
light original, or an original with pasted parts or photographs (see ‘The 
exposure settings’ on page 48). 

With the Océ TDS320 you can do a number of basic tasks. These tasks include:
■ Turn on, turn off the scanner
■ Make copies
■ Select the required media
■ Select the manual feed
■ Specify the zoom factor
■ Select the exposure setting
■ Select to add or remove a strip
■ Select the input mode
■ Select the output mode
■ Select extra settings
■ Deliver originals after scanning
■ Define settings for the next original
■ Select autofeed of the original
■ Stop a copy job
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You can also do a number of special copy jobs. These special copy jobs 
include:
■ Copy non standard size originals
■ Define the copy size
■ Define image quality: Optimization for line/text/photo or blueprint mode
■ Background compensation for line/text/photo or blueprint mode
■ Edit function: mirror

Turn on and turn off the Océ TDS320 scanner

To turn on the system:
■ turn on the scanner.
■ turn on the printer (see page 21). 
■ turn on the controller(see page 22).

When you turn on the system, it is ready for operation. In this state, the 
machine is in the stand-by mode. There is no need to turn it off after each copy 
job. You can leave the system turned on for the rest of the day. At all times, the 
Océ TDS320 is ready to use.

If the system is not in use for more than 1 minute, the operator panel returns 
automatically to the stand-by mode. The operator panel of the scanner is 
activated in the following conditions:
■ you feed an original
■ a key on the operator panel is pressed

▼ Turn on the scanner

1 Set the ON/OFF switch at the rear of the scanner, to position ‘1’ (see figure 9). 
If the power supply is connected, the green switch lights up. 

[9] On/off switch of the scanner
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Note: The system is ready to use. You can turn ON and OFF the scanner 
separate from the printer and without any particular order.

▼ Turn off the scanner

1 Set the on/off switch at the rear of the scanner, to position ‘0’ (see figure 9).

Start the copy process

If you press the Start key, and you do not change any settings, the settings of 
the previous copy job are used or the default settings of the machine are used:
■ number of copies 1
■ use roll 1
■ zoom 100%
■ synchro cut
■ no leading or trailing strip
■ auto exposure on; exposure setting 0.

Default settings are used in the following situations:
■ after turn on
■ after you press ‘cancel’ twice
■ after a time-out of 1 minute (since the end of previous copy job has expired).

If the Start key is pressed the original will be scanned. The original returns to 
the operator if you have enabled the rewind function (see page 50). You can 
make settings for the next job.

When the original returns, remove the original. A new original can be fed and 
you can program new settings. 

Make copies

The copying process starts when you press the Start key. Before you press the 
Start key, you can change the settings.

▼ Feed the original

1 Insert the original face down and right aligned, along the original guide line on 
the scanner feed table so that you can see the line (see figure 10).
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[10] Insert the original

The original will be transported about 1 centimeter to a defined position.
2 Specify the number of copies with the ‘+’ or ‘-’ keys.
3 Press the ‘media’ key to select a roll or to select ‘manual feed’.
4 Press the ‘input’ key to specify how a job is sorted: ‘sheet’ (output 1-1, 2-2, 

3-3, or ‘set’ (output 1-2-3, 1-2-3).
5 Press the ‘zoom’ key to specify a reduction or an enlargement factor, if needed.
6 Press the ‘exposure’ key to correct for a lighter or darker original, if needed.
7 Press the ‘strip’ key to add or remove a strip, if needed.
8 Press the green Start key to start the copy job. The original is fed into the 

scanner. The printer starts.
9 Collect your output. 

If you make a copy within the time-out of 1 minute, the machine will use the 
settings of the previous copy job.

Number of copies

To have multiple copies from one original, enter the number of copies on the 
scanner operator panel. The original is scanned just once and the required 
number of copies are processed.

Refer to ‘Product specifications Océ TDS320’ on page 135 for the limitation 
of multiple copy jobs.
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▼ Select the number of copies

1 Enter the number of copies (1 up to 99) with the ‘+’ or ‘-’ key on the scanner 
operator panel.
The display shows the number of copies.

Select the use of roll 1 or roll 2 or manual feed

You can select between two rolls or manual feed with the ‘media’ key. When 
a roll is selected, the copy material is taken from the selected roll. 

Note: Only use paper as specified in ‘List of available material types and sizes’ 
on page 139.

▼ Select roll 1, roll 2

1 Press the ‘media’ key until the indicator that matches your selection lights up.
2 Enter the media width if you have selected ‘Manual feed’ (see ‘Media type and 

size on the printer’ on page 23).
3 Set the correct media type settings (see ‘Set the media type settings’ on 

page 24).
4 Press the confirm key.
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Select the input mode

You can use the ‘Input’ setting to indicate how a job is sorted: the ‘sheet’ 
option prepares each sheet as a separate job (see figure 11).

Select ‘set’ to keep the copies together and to prevent the interruption with a 
print job. ‘set’ makes a copy for each sheet in a set and continues with the next 
copy of the complete set (see figure 11).

:

[11] Difference between the ‘sheet’ option and the ‘set’ option

▼ Select the input mode

1 Press the ‘input’ key to select the input mode ‘sheet’ or ‘set’.
The selected indicator lights up.

To copy sets

Use the input mode ‘set’ to copy sets of originals. The originals will be scanned 
sheet by sheet and the image information will be stored in memory. When you 
press the Start key to close the set the printer prints the output.

▼ How to copy sets

1 Press the ‘input’ key to select the input mode ‘set’.
2 Insert an original.
3 Add the originals to the set and press the Start key .
4 After the last scan of the set, remove the original and press the Start key  to 

close the set.

page 1
page 1
page 1
page 2
page 2
page 2
page 3
page 3
page 3

page 1
page 2
page 3

page 1
page 2
page 3
page 1
page 2
page 3

Output with the input mode ‘sheet’ Output with the input mode ‘set’. 

Print 3 copies of a 3 - page document
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Specify the zoom factor

With the Océ TDS320 you can reduce or enlarge your original from 25% to 
400%. Press the ‘zoom’ key to enter the zoom mode. You can select the zoom 
factor by means of the ‘browse’ keys when the indication flashes. 
Choose between the fixed step zoom mode by means of the right and left 
browse keys. In fixed steps mode 8 pre-set zoom settings are available. Choose 
the% zoom mode by means of the up and down browse keys. 

Note: You can configure the fixed zoom steps in the Océ Settings Editor. Also 
refer to ‘Summary of standard zoom formats’ on page 142.

▼ Select the zoom factor with pre-set zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the  or  key.

The display shows the selected ratio. If you make the adjustments with this key, 
one of the indications above the key flashes. If the adjustment is different from 
the default setting, the indication lights up. 

▼ Select the zoom factor with 1% zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the  or  key.

The display shows the selected ratio. If you make adjustments with this key, 
one of the indications above the key flashes. If the adjustment is different from 
the default setting, the indication lights up. 

The exposure settings

You can modify the exposure quality to improve the image quality. To modify 
the exposure you can choose between:
■ use of the lighter and darker keys
■ enable or disable automatic background compensation
■ adjust the Océ Image Logic® based on the original type you want to copy

The default exposure settings make background-free copies of most line 
drawings. The automatic background compensation is activated. The 
background is measured when you scan an original. The result of some 
originals cannot match your requirements.
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When you copy very light or dark originals, or originals with unequal 
background density, the result cannot meet your requirements (e.g. too much 
background).

Default the automatic background compensation is active and the exposure 
level is 0.

The automatic background compensation will provide a good quality copy 
from a large variety of originals. The automatic background compensation 
setting, which is switched on (by default), ensures the production of 
background-free copies of most line drawings. 

▼ Adjust the exposure setting

1 Press the ‘Exposure’ key.
2 Select the needed exposure value with the  or  key.

▼ Set the automatic background compensation

1 Press the Extra key.
2 Select ‘Original’ with the  or  key. 
3 Press the  key to enter the ‘Original’ menu.
4 Select ‘Background comp.’ with the  or  key.
5 Press the  key to enter the ‘Background comp. menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the confirm key.

The Océ TDS320 allows you to adjust the exposure setting according to the 
type of image on the original. There are three original types available:
■ Lines/text
■ Photo
■ Blueprint

By default ‘Lines/text’ is selected with the background compensation enabled. 
This is the best setting for originals with characters and line art.
■ Select ‘Photo’ when the original consists of a combination of characters, line 

art and picture images.
Note: If you select ‘Photo’, the ‘Background compensation’ will be 
switched off automatically.
■ Select ‘Blue print’ when you want to copy an original with an image in 

negative (image in white on dark background). The copy will be positive 
(image in black on white background).
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▼ Improve the copy quality according to the type of image

1 Press the Extra key.
2 Select ‘Original type’ with the  or  key.
3 Press the  key to enter the ‘Original type’ menu.
4 Select ‘Lines/text’, ‘Blueprint’ or ‘Photo’ with the  or  key.
5 Press the  key to enter the ‘Lines/text’, ‘Blueprint’ or ‘Photo’ menu.
6 Select the needed original type.
7 Press the confirm key.

Deliver originals after scanning

You can choose for delivery of the original at the front (rewind) or the rear side 
of the scanner. Use the output at the rear side of the scanner if your originals 
are:
■ thick
■ very thin
■ damaged
■ in a carrier sheet.

The rewind setting will return to default when,
■ the ‘cancel’ key is pressed,
■ the panel time out has exceeded.

▼ Enable the rewind function

1 Press the Extra key.
2 Select ‘Scanner’ with the  or  key.
3 Press the  key, to enter the ‘Scanner’ menu.
4 Select ‘Rewind original’ with the  or  key.
5 Press the  key, to enter the ‘Rewind original’ menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the ‘confirm’ key.

Enable automatic feed of the original

To increase the productivity enable Automatic feed, no need to press the Start 
key, except for the first original. If you disable automatic feed you must press 
the Start key.
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▼ To enable automatic feed

1 Press the Extra key.
2 Select ‘Scanner’ with the  or  key.
3 Press the  key, to enter the ‘Scanner’ menu.
4 Select ‘Autofeed orig.’ with the  or  key.
5 Press the  key, to enter the ‘Autofeed orig.’ menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the ‘confirm’ key.

Define settings for the next original

For each original you need to copy you can specify new settings. 

▼ Define settings for the next copy job

1 Select all the needed settings for the next original.
2 Insert the next original.

Copy on pre-cut sheets

If you copy a job on a media type and/or size that is not available on one of the 
paper rolls, you can manually feed sheets instead of reloading paper rolls. You 
can insert pre-cut copy material in this slot, one sheet at a time. To set the time 
out for manual feed refer to ‘Set the time-out for manual feed’ on page 53.

▼ Copy on pre-cut sheets

1 Enter the type of the copy material on the printer operator panel.
2 Press the ‘media’ key on the scanner panel to select ‘manual feed’. The 

indicator lights up.
Note: The minimum length of the print material must be 420 mm.
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[12] Manual feed

3 Enter the number of copies.
4 Select the copy size.
5 Feed the original.
6 Press the Start key .
7 Take your sheet of copy material to the side of the printer that contains the 

sheet feed (see figure 12). 
8 Align the copy material with your hands to the format indication and the label 

on the manual feed table.
9 Move the copy material forward in the cut of the roller. A paper bulge must 

appear over the full width of the page.
10 Hold the paper with your hands until the printer pulls in the first part of the 

sheet.
The bulge decreases or disappears. After a few seconds, the printer pulls the 
complete sheet.
Note: If the copy job requires more sheets, the display indicates to feed the 
next sheet.

11 Repeat steps 7 to 10 to complete the job.
12 Collect your output.

Note: The printer prints the image on the side of the sheet which is facing up.

Attention: When you feed a sheet of material in the manual feed while a 
normal print job runs, a media jam can occur.
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▼ Set the time-out for manual feed

Default is 60 seconds.

1 Press ‘on-line’ on the printer operator panel, to enter the main menu.
2 Select the ‘media settings’ item with the  or  key.
3 Press ‘next/select’ to enter the ‘media settings’ menu.
4 Select ‘manual feed’ with the  or  key.
5 Press ‘next/select’ to enter the ‘manual feed’ menu.
6 Select the ‘time out’ with the  or  key. 
7 Press ‘next/select’ to enter the ‘time out’ menu.
8 Select the desired time out with the  or  key.
9 Press ‘next/select’ to confirm the selected timeout.

10 Press ‘on-line’ to leave the main menu.
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Stop a copy job

Press the ‘cancel’ key to interrupt the original transport. 

▼ Stop a job

1 Press the ‘cancel’ key.
The original transport is stopped.

2 The message ‘Remove original’, ‘Press cancel’ appears on the scanner display.
3 Open the scanner cover and remove the original.
4 Close the cover.
5 Press the ‘cancel’ key. The message disappears on the scanner display.

Set synchro or standard cut

In synchro cut mode, the copy is cut at the length of the original. The length 
depends on the zoom factor and the leading or trailing strip setting. The default 
is Synchro cut mode.

In standard cut mode, the copy is cut at a standard format length (portrait). You 
select the length of the standard format with the ‘browse’ keys.  
Example: select 36 inches, means select a format of 36 inches width and a 
corresponding 48 inches length. Independent of the roll width, the material is 
cut at a length of 48 inches.

When you select standard cut, the system always cuts at the selected length. If 
the original length is shorter or longer than the selected length, the cut is made 
at the selected length. 

▼ Select synchrone cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press  key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the  or  key.
5 Press  key, to enter the ‘cut length’ menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the ‘confirm’ key.
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▼ Select standard cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press  key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the  or  key.
5 Press  key, to enter the ‘cut length’ menu.
6 Select a standard paper format with the  or  key.
7 Press the ‘confirm’ key.

Adjust the leading or the trailing strip

To increase the copy length to accommodate for a filing strip select a positive 
leading or trailing strip. 

If you do not want the filing strip to show on the copy, select a negative leading 
or trailing strip. The adjustment steps are indicated on the operator panel, 
expressed in millimeters or 0.1 inches. 

▼ Adjust the leading or the trailing strip

1 Press the ‘strip’ key to toggle between ‘leading’ and ‘trailing’ strip. 
2 Select a positive or negative value in steps of 10 mm with the  or  key.
3 Select a positive or negative value in steps of 1 mm with the  or  key.

The length of the selected strip is shown in the display. If the adjustment differs 
from the default setting, the indication lights up. 

Attention: If you make the strip larger than the strip on the original, you can 
lose information.
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Leading and trailing strip  It is possible to adjust the length of both the leading 
and trailing strip to eliminate or add a filing strip. Leading and trailing strips 
can be extended up to 400 mm or shortened up to 400 mm (see figure 13).

[13] Example of adjusting the leading and trailing strip of an original 

Trailing strip
- 400 mm

Trailing strip
+ 400 mm

Leading strip
- 400 mm

Leading strip
+ 400 mm
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Mirror-image copies

You can make a mirror-image copy of an original, as shown in the next figure:

[14] Example of a mirror-image copy

▼ To make a mirror-image copy

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press the  key to enter the ‘Paper copy’ menu.
4 Select ‘Mirror’ with the  or  key.
5 Press the  key to enter the ‘Mirror’ menu.
6 Select ‘on’ or ‘off with the  or  key.
7 Press the confirm key.

Release original

For originals on thinner types of media you can enable Release original. With 
Release original enabled the original will be fully released after it is scanned.

1 Press the Extra key.
2 Select ‘Scanner’ with the  or  key.
3 Press the  key to enter the ‘Scanner’ menu.
4 Select ‘Release orig.’with the  or  key.
5 Press the  key to enter the ‘Release orig.’ menu
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the Confirm key.
8 Make other settings if required.
9 Feed the original.

10 Press the Start key. 
The original is fully released after the scanner has completed its scan run.
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Menu structure of the scanner
f

Lines/text 
Original type Blueprint 

Original Photo 
  

Background comp. on 
off 

Synchro cut 
Standard cut 

A0 (841x1189mm) 
A1 (594x841mm) 
A2 (420x594mm) 
A3 (297x420mm) 
E (34x44 )  
D (22x34 )  
C (17x22 )  

Cut length B (11x17 )  
E+ (36x48 )  
D+ (24x36 )  

Paper copy C+ (18x24 )  
B+ (12x18 )  
30 x42  

B1+ (707x1000mm)
B2+ (500x707mm) 
B2 (500x700mm) 

 
Mirror on 

off  

Rewind original on 
off 
 

Autofeed orig. on 
off 
 

Release orig. on 
off 

Scanner  
US English 

Language Nederlands 
more... 

 
Print menu chart Printing... 
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Chapter 4 
Use the Océ TDS320 to Scan to file

This chapter describes the scan-to-file functionality of the 
Océ TDS320. This chapter contains a description of the 
interface of the Océ TDS320 scanner, and of the Océ Scan 
Manager and Océ View Station LT applications on the 
local controller
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Introduction

‘Océ Scan Logic®’ is an option which enables you to scan a document and 
send it to a specific directory on the network. It makes full use of Océ Image 
Logic®, a quality enhancement technology. Enable Océ Scan Logic® through 
a password in the Océ Settings Editor. A graphical user interface is supplied 
with the ‘Océ Scan Logic®’ option.

You scan in order to:
■ Use the documents again
■ Archive the documents
■ E-mail the documents
■ Print the documents at a later time

A scan is made at the Océ TDS320 scanner. On the scanner operator panel, you 
select the resolution and the destination of the scan. 

You can store a generated file on the controller (temporary store) or move the 
scan towards a network destination. 

With Océ View Station LT you can see the scanned documents later. Océ View 
Station LT comes with the Océ Scan Manager application.

Note: The optional Graphical User Interface (GUI) on the controller is 
required to use Océ Scan Logic®. 
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Make a scan

To scan an original to file is an easy operation. If the settings (see ‘Settings to 
scan’ on page 62) are correct, you must press the Start key  on the scanner 
operator panel.

▼ How to make a scan

1 Place your original face-down, right aligned along the original guide.
2 Select the appropriate original type.
3 Press the Output key to select ‘File’.
4 Select a Destination (see ‘Destinations’ on page 70).
5 Press the Start key .

The original is scanned. 
Note: Select auto-feed on/off, rewind original on/off, and release paper 
on/off in the ‘scanner’ menu on the scanner panel (see ‘Menu structure Océ 
TDS320 Scanner’ on page 66). When release paper is enabled, the original 
will be fully released after it is scanned.

6 On the controller, Océ View Station LT starts, to show the result of the scan 
(see figure 15).

[15] Océ View Station
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Settings to scan

Press the Extra key on the scanner operator panel to access the settings to make 
a scan. The following options are available in the ‘File’ menu:

Destination  You can store your scan either in the temporary storage on the 
controller or you can store it on a network destination. You can define a 
maximum of six destinations in the Scan Manager application. You can select 
one of these destinations on the scanner operator panel.

Checkprint  A Checkprint is a print from the scanned original. You can turn the 
checkprint on or off.

File resolution  The Océ TDS320 Scan Logic® option can scan three 
resolutions: 200, 300 or 400 dots per inch (DPI). The higher the resolution, the 
better the image quality. Higher resolution also causes larger sizes of files.

File format  To define the internal order of the scanned files, select between 
TIFF (Tagged Image File Format), CALS-I (Continuous Acquisition and Life 
Cycle support), or PDF (Portable Document Format).

Optimize size  Select this option to decrease the size of the file or to get good 
quality.

Set the scan size In the ‘Original’ menu.

Destination

You can store your scan either in the temporary store on the controller or on a 
network destination. You can define up to six destinations in the Océ Scan 
Manager application. On the scanner operator panel you can choose one of 
these destinations.

▼ Select a destination

1 Press the Extra key.
2 Select ‘Destination’ with the  or  key.
3 Press the  key, to enter the ‘Destination’ menu.
4 Select the needed ‘Destination’ with the  or  key.
5 Press the Confirm key.
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Note: The names of the destinations can be any. However, for your 
convenience, you are able to define understandable nicknames in the Océ Scan 
Manager application (see ‘Create a local destination’ on page 70).

Checkprint

A Checkprint is a print from the scanned original. You can turn Checkprint on 
or off.

▼ Select Checkprint

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘Checkprint’ with the  or  key.
4 Press the  key, to enter the ‘Checkprint’ menu.
5 Select ‘on’ or ‘off’ with the  or  key.
6 Press the Confirm key.

Resolution

The Océ TDS320 Scan Logic® option can scan three resolutions:
■ 200 dots per inch (dpi)
■ 300 dpi
■ 400 dpi

To reach the best print quality on the Océ TDS320 select 300 dpi.

▼ Select the resolution

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘File resolution’ with the  or  key.
4 Press the  key, to enter the ‘File resolution’ menu.
5 Select the needed resolution with the  or  key.
6 Press the Confirm key.
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File format

To define the internal order of the scanned files, select between TIFF (Tagged 
Image File Format), CALS-I (Continuous Acquisition and Life Cycle support), 
or PDF (Portable Document Format).

Within the ‘Tiff format’ option, you can define 9 different Tiff subformats. The 
‘Organization’ and ‘Compression’ of the file are determined by the Tiff 
subformat you select.

Organization
■ Stripped
■ Tiled
■ Raw

Note: Select ‘Stripped’ or ‘Tiled’ when you can use these organizations later. 
Select ‘Raw’ in another case.

Compression
■ Group 4
■ Group 3-1D
■ None

Note: Select ‘Group 4’ or ‘Group 3-1D’ when you can use these compressions 
later. Choose ‘None’ in another case.

Note: ‘Group 4’ or ‘Group 3-1D’ are compression methods which are best for 
text and vector drawings. If you select these compressions to scan a photo with 
many gray scales these compressions can cause a negative compression: the 
file size increases instead of decreases.

▼ Select file format

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘File format’ with the  or  key.
4 Press the  key, to enter the ‘File format’ menu.
5 Select the required format or subformat with the  or  key.
6 Press the Confirm key.
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Optimization

You can turn File size optimization ‘on’ or ‘off’. If you select ‘on’ the file size 
is smaller, the scan quality will be less.

▼ Select optimize size

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘Optimize size’ with the  or  key.
4 Press the  key, to enter the ‘Optimize size’ menu.
5 Select ‘on’ or ‘off’ with the  or  key.
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Menu structure Océ TDS320 Scanner

 

w=A0 l=synch l= synch 

w=A1 l=synch   A0 

w=A2 l=synch  

w=A3 l=synch  

w=A4 l=synch  

w=34  l=synch   

w=22  l=synch   

Standard size w=17  l=synch   

w=11  l=synch   

w=8.5  l=synch   

Scan size w=36  l=synch    

w=24  l=synch   

w=18  l=synch   

w=12  l=synch   

w=9  l=synch   

w=30  l=synch   

  w=B1 l=synch   
  w=B2 l=synch   

Original  w=B1+ l=synch   
  w=B2+ l=synch   

  

Custom width w=123mm l=synch 
  

Custom size w=123mm l=12.3  
 

Lines/text 
Original type Blueprint  

Photo 
  

Background comp. on 
off 

Destination 1 
Destination 2 
Destination 3 

Destination Destination 4 
 Destination 5 
 Destination 6 
  

Check print on 
 off 

File 200 dpi 
File resolution 300 dpi 

400 dpi 
 

TIFF G3 RAW 
TIFF G3 strip 
TIFF G3 tiled 
TIFF G4 RAW 
TIFF G4 strip 

File format TIFF G4 tiled 
TIFF unc. RAW 
TIFF unc. strip 
TIFF unc. tiled 

CALS 
PDF unc. 
PDF G4 

 
Optimize size on 

off 

Rewind original on 
off 
 

Autofeed orig. on 
off 
 

Scanner Release orig. on 
off 
 

US English 
Language Nederlands 

more... 
 

Print menu chart Printing... 
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Océ Scan Manager

The Océ Scan Manager is an application available locally on the controller. 
With the Océ Scan Manager you can configure the destinations for Océ Scan 
Logic®. To increase your productivity you can define automatic file naming. 
This way you can do batch scans without operating the controller.

During scanning, Océ Scan Manager displays the filename and the status of the 
file generation process. When the scan is completed a view of the scanned 
image is automatically displayed on the controller.

Figure 16 shows an example of the Océ Scan Manager application. The left 
part displays a tree view containing folders containing destinations. The right 
part displays a table view containing the content of the folder currently 
selected.

[16] Overview of the Océ Scan Manager application

Note: Not all options are available to all users. You must log on to a particular 
user mode to do specific tasks with Océ Scan Manager (see ‘Océ TDS320 
users’ on page 13).
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Tree view

The tree view displays:
■ the system name
■ the collapsible destination tree
■ the collapsible temporary store tree.

If you scan to a particular destination, that destination is displayed bold and the 
corresponding icon changes. The destination you scanned last to, is displayed 
bold.

If for any reason a scan can not be sent to the correct remote destination, the 
file is stored in the ‘Unsent’ folder.

Table view

The table view (on the right side of figure 16 on page 67) displays the file 
names of the files in the opened destination or temporary folder. 

Each file has the following information:
■ Name
■ Size
■ Type
■ Modified
■ Resolution
■ Image size.

If the currently viewed destination is the one you are scanning to, then the 
scanned file appears at the end of the table. If you currently view another 
destination than the one you are scanning to, then the scanned to destination is 
displayed bold.

It is possible that there are more files in the table than fit on screen. The most 
recent scanned file appears at the end of the table. Under these circumstances 
it is possible that your most recent scanned file is not visible in the table on 
screen. In this case you can update the table view.
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▼ Update the table view

1 From the ‘View’ menu select ‘Refresh’ or click the ‘Refresh’ button on the 
toolbar (see figure 17). If the opened destination is also the one which is 
currently scanned to, then the view is automatically updated.

[17] ‘Refresh’ button on the toolbar
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Actions from the Océ Scan Manager

The Océ Scan Manager enables you to make settings for scan-to-file. You can 
edit and view the destination properties. You can also view the properties of 
scanned files.

Destinations

A destination is a location where you scan your file to. You can create, delete 
and lock destinations. You can also define automatic file naming to ensure your 
files get the desired names.

A destination can also be a file server or a PC of an end user. It is better to select 
remote destinations instead of the local ones. The local destinations are 
temporary and can only contain a limited number of scan files. Define the 
‘Scan memory reservation’ in the Océ Settings Editor. See the on-line help on 
the Océ Settings Editor for more details.

▼ Create a local destination

1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the 

toolbar (see figure 18).

[18] ‘New’ button on the toolbar



Use the Océ TDS320 to Scan to file 71

[19] ‘Destination properties’ window

3 Enter a logical name for the destination in the ‘Name’ text box.
4 This logical name also appears on the scanner panel S.
5 Select the ‘On the controller’ type from the ‘Type’ drop-down list box.
6 Enter a path of the target folder in the ‘Path’ text box. You can also click the 

‘Browse’ button to select the path.
7 This is only possible if you select ‘On the controller’ as ‘Type’ (see step 4).
8 Click Ok to accept the destination properties.

▼ Create a network destination with SMB

1 Create a shared folder on a workstation. For example c:\Scan
2 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see figure 18).  
The Destination Properties dialog box appears (see figure 19)

3 Select SMB from the ‘Type’ drop-down list box.
4 Enter the system name of the workstation where you created the shared folder.
5 Find the system name of the workstation on the control panel of the 

workstation (Control panel - Network - Identification - System name)
6 Enter the path name. This is the name of the shared folder on your workstation. 

For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder. 
For Windows 95/98® use the folder name. This is case sensitive.

7 You cannot Browse. Instead of entering the path name by hand, you can use the 
drop-down list box to select a shared folder available on the selected system.

8 If you have set a username and a password for the shared folder on the 
workstation, then enter the username and the password in the required fields.
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9 Set the required file naming properties
10 Click OK 

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
then shows the contents of the new SMB destination.

▼ Create a web destination with FTP

1 Create a home directory and a subdirectory on a workstation. For example 
c:Ftp/Scan

2 Enable FTP on the workstation
3 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see figure 18).  
The Destination Properties dialog box appears (see figure 19)

4 Select FTP from the ‘Type’ drop-down list box.
5 Enter the system name of the workstation where you created the shared folder. 

Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6 Enter the path name. This is the name of the shared folder on your workstation. 
For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder. 
For Windows 95/98® use the folder name. This is case sensitive.
Note: You cannot Browse.

7 For access to the directory on the workstation through FTP, a user name and 
password is set on the FTP server that runs on the workstation. Enter this user 
name and this password in the required fields on the Destination Properties 
dialog box of the Océ Scan Manager.

8 Set the required file naming properties
9 Click OK 

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
then shows the contents of the new FTP destination.

Note: You can create a maximum number of 6 destinations.
Note: Names in Japanese can only be entered for remote destinations in 
SMB.
A key operator can determine whether a destination can be modified by an 
anonymous user. This is done by locking and unlocking a destination.

▼ Lock a destination

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.
3 Check the ‘Locked’ check box.
4 Click ‘OK’ to accept the destination settings.

The destination properties are now locked.
Note: This option is only available if you are logged on as a Key operator.
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▼ Unlock a destination

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.
3 Uncheck the ‘Locked’ check box.
4 Click ‘OK’ to accept the destination settings.

The destination properties are now unlocked.
Note: This option is only available if you are logged on as a Key operator.

▼ Delete a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see figure 20).

[20] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or 
as a Repro operator.

Note: You are not able to delete the last destination.

▼ Define a file name

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.

The ‘Destination properties’ screen appears (see figure 19 on page 71).
3 Enter a name in the ‘Base name’ text box.

Note: The ‘Base name’ may contain ‘###’ for automatic file naming. The 
‘###’ will be replaced by an ascending number. You may place as many 
dots in the ‘Base name’.

4 Select or clear the check box ‘Add correct file extension’ to add or leave out 
the file extension. Set the file extension in the Océ Settings Editor.

5 Click ‘Apply’ or press Enter to accept the settings.
When you scan, the scanner operator panel displays the file name.
Before a new scan-to-file job, enter a new file name or replace the file name 
with ###. When the file name is not changed, the new scan-to-file job 
overwrites the previous scan-to-file job.
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▼ Set or Change destination properties

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’ or click the ‘Properties’ button on the 

toolbar (see figure 21).

[21] ‘Properties’ button on the toolbar

The ‘Destination properties’ screen appears as in figure 19 on page 71.
3 Change the destination properties as described in ‘Create a local destination’ 

on page 70.

Scanned files

The right pane of the Scan Manager contains the scanned files and additional 
information about the files. You can view, print and delete these files. You can 
also view the file properties.

▼ View a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘View’ or click the ‘View’ button on the toolbar 

(see figure 22).

[22] ‘View’ button on the toolbar

Océ View Station LT starts and displays the file.
Note: When you make a scan Océ View Station LT starts automatically, and 
shows the result of the scan.

▼ Print a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Print’ or click the ‘Print’ button on the toolbar 

(see figure 23).

[23] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the Océ 
Settings Editor.
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▼ Delete a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Delete’ or click the ‘Delete’ button on the toolbar 

(see figure 24).

[24] ‘Delete’ button on the toolbar.

The selected file will be deleted.
Note: This option is only available if you are logged on as a Key operator 
or as a Repro operator.

▼ View properties of a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Properties’ or click the ‘Properties’ button on the 

toolbar (see figure 25).

[25] ‘Properties’ button on the toolbar.

The following window appears (see ‘‘Scanfile properties’ window’ on 
page 75):

[26] ‘Scanfile properties’ window

3 Click ‘OK’ to close the ‘Scanfile properties’ window.
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▼ Automatically view a file after scanning

You can choose to view a file automatically after scanning:
1 From the ‘System’ menu select ‘Auto view’.

When you scan, Océ View Station LT starts automatically and show the 
scanned file.

Manage the temporary store

When you normally scan the originals to a file, many files are created in the 
temporary store. You can clean the temporary store:
■ manual: from the ‘System’ menu select the ‘Purge’ command.
■ automatic: you must make some settings in the Océ TDS320 Settings Editor.
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How to retrieve scanned files

When you scan your files will be stored in the destination you set. This can be 
on the local controller or on a remote system. You can retrieve your files from 
the local host via File Transfer Protocol (FTP) (see figure 27). Also if during 
scanning to a remote destination, something goes wrong, you can retrieve your 
files from the local host.

[27] How to retrieve scan files

Remote client

Remote client

Power Logic Controller
Windows XP®

Get files via FTP

Get files via FTP
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Get files via FTP

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box now appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Océ 

Power Logic® Controller or the IP address (for example: 194.2.66.146) to 
connect to the Controller and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3 you could also enter “ftp 
host_name” in the FTP client.
The connection with the Controller is now established and a window appears 
asking you for a user name.

4 Enter your user name ‘anonymous’, and enter as your password also 
‘anonymous’. 
A connection is now set up for the default user ‘anonymous’.
Note: As there is no registered user, you can press Enter to initiate the 
connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
7 Go to the ‘scan’ directory if you want to retrieve a file from a destination on 

the local host, 
or
go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder 
on the local host.

8 Get the data file (for example: bugatti.tif) via the ‘get’ command: 
‘get bugatti.tif’.

9 Quit FTP by entering the ‘bye’ command.

Note: You can retrieve multiple files by the ‘mget *’ command or the ‘mget .‘ 
command. Which command you can use is release dependent.
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Océ View Station LT

With Océ View Station LT you can view your scanned files. This can be 
automatically (see ‘Automatically view a file after scanning’ on page 76) after 
scanning or via Scan Manager (see ‘Print a scanned file’ on page 74).

Océ View Station LT has the following menu’s (see figure 28):
■ File
■ View
■ Preference
■ Help

[28] Océ View Station
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Menu options

File menu
Command What does it do
Close Closes the active document
Properties Provides technical information about, and allows you to change cer-

tain properties of the document.

[29] 

View menu
Command What does it do
Fit Scales the image to fill the window.
1:1 Displays the image at a 1:1 scale factor.
Magnify Zooms into the page.
Reduce Zooms out of the page.
Refresh Redraws all windows displaying the active document.
Invert Reverses the black and white parts of the image.
Mirror Mirrors the image.
Rotate 90 CCW Rotates the image 90 degrees counterclockwise.
Rotate 90 CW Rotates the image 90 degrees clockwise.
Rotate 180 Rotates the image 180 degrees.
Sample When active, displays only a sample of bilevel raster pixels.
Negate Reverses the raster image pixels on display and changes which are 

dominant for scaling. 
Scale to gray When active, displays the active bilevel raster image as though it 

were a grayscale image. 
Monochrome An image or screen having only background and foreground colors. 

Same as black-and-white or bilevel.

[30] 

Preference menu 
Command What does it do
View ribbon View Ribbon displays and removes the ribbon that contains but-

tons. The View Ribbon appears, by default, below the menu bar. It 
serves as a fast means of selecting some File, View, and Preference 
menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of the 
Océ View Station LT window. The Status Bar displays the pointer 
co-ordinates and a status line.

[31] 
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Note: You can retrieve help about Océ View Station LT via the Océ Scan 
Manager.

Function buttons

Below the menu’s there are function buttons in a ribbon. This ribbon can be 
turned on and off (see ‘View ribbon’ on page 80). 

[33] Function buttons in Océ View Station

The above figure displays the buttons:
1 Invert: Reverses the black and white parts of the image.
2 Fit: Scales the image to fill the window.
3 1:1: Displays the image at a 1:1 scale factor.
4 Magnify: Zooms into the page.
5 Reduce: Zooms out of the page.
6 Mirror: Mirrors the image.
7 Rotate 90 CCW: Rotates the image 90 degrees counterclockwise.
8 Rotate 90 CW: Rotates the image 90 degrees clockwise.
9 Rotate 180: Rotates the image 180 degrees.

10 Measurement When active, allows you to measure lines and areas on the 
image.

Reference Reference displays or removes a small, usually floating window. 
This window displays the entire current page in miniature. The 
crossed box inside the Reference window indicates which part of 
the page is displayed in the document window.
By moving or resizing the crossed box, you change which area of 
the page is displayed.

Detail Displays or removes the Detail window.
Measurement When active, allows you to measure lines and areas on the image.

Help menu
Command What does it do
About Shows information about Océ View Station.

[32] 

Preference menu (continued)
Command What does it do

[31] 

2 3 4 5 6 8 9 10 11 121 7
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11 Reference. This small floating window displays the entire current page in 
miniature for reference.

12 Displays or removes the Detail window.

View error

When the memory is almost full it can occur that the viewer does not show the 
scanned file. Instead it shows a red border with a red cross (see figure 34).

[34] Error view in Océ View Station
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Chapter 5 
Install and start Océ Remote 
Logic® on a workstation

This chapter describes how to install and start Océ Remote 
Logic® on a workstation.
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Introduction

Océ Remote Logic® to access the Océ Settings Editor (‘Océ Power Logic®: 
The Settings Editor’ on page 95) from a remote workstation.
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Installation procedure for MS Windows® 
systems

Before you install Océ Remote Logic®, you must take note of the following 
minimum system requirements for the remote system. The system must be a 
Pentium® 233 with 32 Mb RAM running Windows 95, 98, NT® (service pack 
3), Windows® 2000, or Windows® XP. Contact your local Océ organization for 
more possible systems.

You will find the Océ Remote Logic® application on the Océ TDS320 
CD-ROM and on the Océ Power Logic® Controller CD-ROM provided with 
the system. The installation procedure for Remote Logic® is quite simple and 
self-explanatory. When you select the ‘Install remote applications’ option on 
the CD-ROM, a Wizard starts to guide you through the installation process. 
When the installation process is complete you do not have to restart your 
system.

Note: Océ Remote Logic® only works when TCP/IP is enabled on your system. 
Refer to your system administrator for assistance with the installation 
procedure for TCP/IP.

▼ Install Océ Remote Logic® 

1 Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® Controller 
CD-ROM into the CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option. 
The installation Wizard starts, and asks to select a setup language.

[35] Choosing a setup language
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3 Indicate the required language and click ‘OK’. 
4 Follow the instructions on screen to complete the installation of ‘Océ Remote 

Logic’.

When the installation is complete, you can start the applications by selecting 
them from the specified folder in the ‘Start’ menu. 

To work with Océ Settings Editor you first have to connect to an available Océ 
TDS320 machine. How to connect is described in ‘How to use the remote 
system’ on page 93
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Installation procedure for Unix systems

Océ Remote Logic® is set up to be platform independent. It runs on a variety 
of operating systems providing that a Java™ runtime environment is available 
for that platform. The Java™ runtime environment must be installed by a user 
with system administrator privileges, depending on Java™ Virtual Machine 
(VM). It is also assumed that Océ Remote Logic® is installed by an 
experienced user.

▼ Install Océ Remote Logic®’

1 Check if a Java™ runtime environment (JRE) is installed on the system. The 
preferred version is JRE 1.1.8. Below you can find some links to JRE's for 
various UNIX platforms.

2 Unpack the contents of the file ‘RemoteLogic_vX.tar’, from the directory 
Products/remotelogic/UNIX, to a subdirectory on the system. 

3 Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.
4 Set the environment variable ‘RL_VM_HOME’ to point to the installation of 

the JVM.
5 Run the file ‘remotelogic’ with Océ Settings Editor as parameter. (remotelogic 

SE). 

Note: If you do not supply any options, a short help text is displayed.

UNIX versions and the required JRE
UNIX version OS version JRE Default installation directory
IBM AIX 4.1.5 1.1.6 /usr/jdk_base
IBM AIX 4.2.1 1.1.8 /usr/jdk_base
IBM AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2
IBM AIX 4.3.3.10 + fix 1.3.0 /usr/jdk_java130
SUN Solaris 2.6 1.1.6
HP-UX 10.20 / 11 / 1.1.8 1.1.3
LINUX 1.0 1.1.3
LINUX 1.2 1.1.8
Note: OS = Operating System, JRE = Java™ Runtime Environment
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IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be 
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote 
Logic® is the 1.1.8 version.

HP-UX

For HP-UX 10.20 and 11.00 the runtime engine can be downloaded from: 
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 10.20 and 
HP-UX 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux which can be downloaded from: 
http://www.ibm.com/java
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Installation procedure for Other systems

In general, Océ Remote Logic® can run on any system with a Java™ VM.

▼ Steps to install Océ Remote Logic® in general

1 Install Java™ Virtual machine (preferred 1.1.8 (or higher)).
2 Extract ‘RemoteLogic_vX.tar’ or ‘RemoteLogic_vX.zip’, from the Océ 

Remote logic® CD-ROM.
3 Set the environment variable RL_VM_HOME to point to the Java™ VM 

installation directory.
4 If needed, edit the remote logic script or batch file.
5 Use remotelogic script or batch file to start the applications.
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Start Océ Remote Logic®
 on your system

▼ Start Océ Remote Logic® 

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select ' Application Launcher'.
3 Select the Océ Settings Editor from the ‘Application Launcher’. 

Command line parameters

In order to start Océ Remote Logic® faster, there are 6 command line 
parameters available.

configfile=<config_file>  Sets the configuration file to use.

server=server  Sets the specified server as the server to connect to.

language1=lang   Specifies the first language in combination with the 
parameter ‘country1=country’.

country1=country  Specifies the first language in combination with the 
parameter ‘language1=language’.

language2=lang  Specifies the second language in combination with the 
parameter ‘country2=country’.

country2=country  Specifies the second language in combination with the 
parameter ‘language2=language’.

Note: You must always use a matching combination of ‘lang’ and ‘country’ 
(see table  on page 91).
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The parameters can be applied to the following application:
■ AL.exe (Application Launcher)
■ SE.exe (Océ Settings Editor)
Note: The.exe file is located in ‘C:\Program Files\Remote Logic\Bin’.

Language
Language Language 

parameters
Country

Danish da DK
Czech cs CZ
Spanish es ES
Finnish fi FI
Hungarian hu HU
Italian it IT
US English en US
UK English en GB
Dutch nl NL
German de DE
French fr FR
Portuguese pt PT
Norwegian no NO
Swedish sv SV
Polish pl PL
Chinese tradi-
tional

cn TW

Chinese simpli-
fied

cn CN

Japanese ja JP
Russian ru RU
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The easiest way to do this is by creating a short-cut of an application and then 
add the command line properties.

Example command line parameter  Below is an example of how to start the 
Océ Remote Logic® applications with the configuration file ‘Myconfig.cfg’, 
connected to the ‘MyTDS320’ server. The first language is set to Japanese and 
the second to French:
‘C:\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg 
server=MyTDS320 language1=ja country1=JP language2=fr country2=FR’.
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How to use the remote system

Start up the Océ Remote Logic® application (Océ Settings editor), on a remote 
client after you have installed the software (see ‘Installation procedure for MS 
Windows® systems’ on page 85). In order to use the functionality you first 
have to add an Océ Power Logic® controller and then connect to an available 
Océ Remote Logic® controller.

▼ Add an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear with a drop-down list box containing the already 
added Océ Remote Logic® systems. 

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address or the name of the Océ Remote Logic® system you want 

to connect to, in the ‘Systems’ text box.
4 Click ‘Add’. The system is added to the list. You can add as many systems as 

you like.
Note: You can also remove an Océ Remote Logic® system. Select one in the 
list and click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ Remote Logic® system, the system has to be 
installed and configured by a system consultant or a technician.

▼ Connect to an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear containing a drop-down list box with the available 
systems. 
Select one of the available systems and click on ‘OK’. When you connect to 
another system, all settings have to be retrieved. This may take some time.
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Chapter 6 
Océ Power Logic®: The Settings 
Editor

This chapter gives information about the Océ Settings 
Editor. For details about specific settings, refer to the Help 
on the Océ Settings Editor.
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Introduction

Use the Océ Settings Editor to set the default settings of the Océ TDS320 
according to your company's requirements. 2 types of users can determine 
settings in the Océ Settings Editor, Key Operators and System Administrators. 
You can log on as either Key Operator or System Administrator. Key Operators 
and System Administrators have different rights to determine settings.
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How to start up and shut down the 
controller

▼ Start up and shut down the controller

1 Press the key on the front of the controller to start up or shut down the 
controller.

After the initial system test of the controller the Océ Settings Editor application 
and the optional Océ Scan Manager application are automatically started and 
the Océ TDS320 is ready for operation.
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Océ Settings Editor

The Océ Settings Editor allows users and operators to view settings of the 
system. If authorized, the settings of the system can be modified on the Océ 
Settings Editor.

With the Océ Settings Editor two groups of settings can be configured:
■ Key Operator settings (KO settings) 

The Key Operator group allows authorized users to configure default settings 
for copy and print jobs and for scan-to-file options. With the Key Operator 
settings also the printer, system and scanner defaults can be set or modified.

■ System Administrator settings (SA settings)  
The System Administrator group allows authorized users to configure 
default printer language (PDL) settings and printer pen settings. It also 
allows the System Administrator to configure system and connectivity 
settings.

These groups of settings can be selected from the ‘View’ menu of the Océ 
Settings Editor.

Setting dependencies  The Océ Settings Editor is used to display and edit a 
specified group of settings. Some settings are related to other settings, 
however. If you want to change settings which have dependencies with other 
settings, you will be prompted with a message. When a setting is changed, the 
system automatically updates the related settings. 

Also, when you change certain settings, such as measurement unit or paper 
series, all related settings are instantaneously converted to the new setting 
(with a bullet for the settings that are changed).
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[36] Océ Settings Editor

General structure

The Océ Settings Editor is structured as follows: 
■ Menu bar
■ Top toolbar
■ Left toolbar
■ Settings area
■ Status bar
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Menu bar

The menu bar of the Océ Settings Editor contains the following menus:   

File   If you select the ‘File’ menu you can log on as a particular type of user, 
log off from the previously selected user mode, open an existing setting file, 
save the current settings to a file, connect to a different controller (only for 
remote users) or exit the Océ Settings Editor.

Edit  If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in 
which you can view your default system and the display languages (first and 
second) for the Océ Settings Editor application. The ‘Automatic logon’ option 
allows you to start the Océ Settings Editor application automatically in the 
specified user mode.

View  The ‘View’ menu allows you to switch between the display languages as 
defined in the Edit options window and to switch between KO settings and SA 
settings.  

Help  The ‘Help’ menu contains the following options: ‘Contents of Océ 
Settings Editor’ and ‘About Océ Settings Editor’.

[37] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons: 
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

[38] Top toolbar

Open  When you click on the ‘Open’ button, you open a saved file. 

Save as  All Key Operator and System Administrator settings can be saved in 
a file. This way you can have different settings for different customers, 
departments or other situations.



Océ Power Logic®: The Settings Editor 101

Note: These settings can only be saved in Key Operator or System 
Administrator mode.

Apply  When you click on the ‘Apply’ button, the changes you have made 
become effective. Initially, this button is disabled. It is enabled after the first 
setting is changed and disabled again after the apply action is performed or 
after an undo action. 

Undo  This button restores the settings to the state it was in the last time the 
settings were applied (and not back to the factory default). Initially, the ‘Undo’ 
button is disabled. This button is enabled the moment the first setting is 
changed. It is disabled after an Apply action is performed or after an undo 
action

Left toolbar

There are four different buttons available at the left toolbar of the Océ Settings 
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button 
provides access to a specific group of settings. By clicking on each of these 
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[39] Left toolbar

Settings area

The settings area consists of two parts: a setting tree and an update area.
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Tree structure  Most settings are displayed using a tree structure. By clicking 
on the settings, folders can be opened to show all the entries or closed to hide 
all the entries below these folders.

The settings for system components that are not available are not displayed. 
So, if you do not have a folder, no folder settings are available. This means that 
different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a 
bullet.

Update area  The user can move through the tree and select a setting. If he 
selects a setting for which he is authorized, he can edit the setting in the update 
area.

If the user is not authorized for a particular setting, the update area is grayed 
and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from 
the tree structure, but are accessed directly from the settings area.

The update area contains some additional information about the selected  
setting. This includes a brief definition of the setting, as well as the minimum, 
maximum and default values (if appropriate).  

[40] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information 
(left to right):

■ System status (icon for connected or disconnected) 
The following icons are used:  

 

The Océ Settings Editor is connected to a system. 

 
The Océ Settings Editor is not connected to a system. 

■ System name (‘localhost’ if you are working at the controller)
■ User mode (Repro operator, Key Operator, System Administrator or 

anonymous)
■ View mode (KO settings or SA settings).

How to access the Océ Settings Editor

In order to perform special Key Operator functions, you must log on to the Océ 
Setting s Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: Only one Key Operator or System Administrator at a time is authorized 
to make modifications. However, there may be multiple users viewing the 
settings. When a second user tries to log on as Key Operator or as System 
Administrator, an error message is displayed.

Start Océ Settings Editor

You can start the Océ TDS applications on the controller as well as on a remote 
workstation.

▼ Start Océ Settings Editor on the Océ Power Logic® Controller

1 Select the 'Launcher' application.
2 Select Océ Settings Editor. Océ Settings Editor starts.



104 Océ TDS320 User Manual

▼ Start Océ Settings Editor on a remote workstation

Note: You must first install Océ Remote Logic® as described in 
‘Installation procedure for MS Windows® systems’ on page 85.

1 Select 'Océ Remote Logic®' via the 'Start' menu.
2 Select the 'Launcher' application.
3 Select Océ Settings Editor. Océ Settings Editor starts.

How to perform actions from the Océ Settings Editor

You can perform a number of activities from the Océ Settings Editor. These 
activities include:

■ Save settings to file
■ Load settings from a file
Save and load settings  All Key Operator and System Administrator settings 
can be saved in a file or loaded from a file. This way you can have different 
settings for different customers, departments or other situations.

Note: These settings can only be saved in Key Operator or System 
Administrator mode. 

▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’.
You now have two possibilities:
■ If the client is a local client, a dialog is displayed and the user can supply a 

file name. The file is saved in a predefined directory on the system. 
■ If the client is a remote client, a dialog box is displayed and the user can 

supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that 
are currently visible.  
 
A few special files are available here:
■ Default.kos/Default.sas  

These files contain the factory default settings for the Key Operator and 
System Administrator, respectively, and cannot be changed.

■ Backup.kos/Backup.sas  
These files contain a previous version of the settings for the Key Operator 
and System Administrator, respectively (before the last Apply).

■ Current.kos/Current.sas  
These files contain the version of the settings for the Key Operator and 
System Administrator after the last Apply.
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When an Apply is performed, first the contents of the current settings is copied 
to the backup file. There are two versions of this file, one for KO settings and 
one for SA settings. These files are always stored on the system.

▼ Load a settings file

1 Open the ‘File’ menu and select ‘Open’.
A dialog box is displayed from where you can choose the right file.

2 Click the ‘Apply’ button. 
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged in as a Key Operator or System 
Administrator.
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Key Operator settings

The Key Operator is responsible for correct default settings of the system. 
These settings include the default settings, and groups of default printer 
settings for the print and the copy jobs that again occur.

The Key Operator can define all timer settings, like the panel time out and the 
sleep mode time out.

Note: One Key Operator or System Administrator can log on to the Océ 
Settings Editor at the same time.

In order to perform special Key Operator functions, you must log on to the Océ  
Setting s Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: When you are finished, make certain you log off from the K ey Opera tor 
m ode of the Océ  Setting s Editor to prevent unauthorized use of the Océ 
TDS320.

▼ Make Key Operator settings in the Océ Settings Editor

1 maximize the Océ Settings Editor on the screen.
2 Log on as Key Operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings are made directly from the tree structure area.
6 Click on the ‘Apply’ button.

The new value is now applied for the setting
Log from the Key Operator mode when you have finished updating the 
settings.
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System Administrator settings

The Océ TDS320 System Administrator is responsible for: 

■ Dithering matrix and Poker settings
■ Printer language controller settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings. 

Note: Poker stands for Portable Kernel. Poker performs automatic 
interpretation of the host language in which the data from the scanner or in the 
job ticket is encoded. Poker makes sure that the quality between the input from 
the printer driver or scanner and the output from the printer is consistent. 
Poker supports data compression for scan-to-file and changes raw data from 
the scanner into high level file formats.

To modify the System Administrator settings you have to access the SA 
settings in the Océ Settings Editor.

There are two types of System Administrator settings (see figure 41):

■ Printer
■ System

.

[41] System Administrator settings in the Océ Settings Editor
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In order to perform special System Administrator functions, you must log on 
to the Océ Setting s Editor as a System Administrator. 

Note: When you are finished, make certain you log off from the System  
Adm inistra tor m ode of the Océ  Setting s Editor to prevent unauthorized use of 
the Océ TDS320.

▼ Make System Administrator settings in the Océ Settings Editor

1 Maximize the Océ Settings Editor on the screen.
2 Log on as System Administrator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the default pen settings, are made directly 
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log off from the System Administrator mode when you are finished updating 
settings.
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Chapter 7 
Printer supplies and maintenance

This chapter describes how to:
■ Load media
■ Refill toner and replace the waste toner bag
■ Clean the glass platen and the reference roller of the scanner
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Media

The Océ TDS320 is available with a roll unit for one or two rolls. 

Each of the rolls on the Océ TDS320 can be loaded with print material of a 
different size or type. The size and type of the available media are indicated on 
the operator panel.

Attention: When you load new print material, you must tell the system the 
size of the material and the type of print material (paper, transparent, or 
polyester). Refer to ‘Media type and size on the printer’ on page 23.

The definition of the size and type of the new print material is required to:
■ Enable the automatic media switch function to work correctly.
■ Support auto format functions.

The paper rolls

When a roll is empty during a print job, a ‘Roll empty’ message is displayed 
at the printer operator panel and on the Océ System Control Panel application. 
You then have to load a new roll of print material.

Note: You can use the following media for the Océ TDS320:

■ Plain paper  64 g/m2 (55 g/m2)
■ Plain paper 75 g/m2 (110 g/m2)
■ Biotop paper 80 g/m2
■ Green label 80 g/m2
■ Recyonomic  80 g/m2
■ Transparent paper 75 g/m2
■ Transparent paper 90/95 g/m2 (80/85 g/m2)
■ Transparent paper 110/115 g/m2
■ Translucent 60 g/m2
■ Vellum 20 lbs (16 lbs)
■ Film 3.5 mil (4 mil)
■ Film 4.5 mil
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Reload paper

▼ How to load roll 1

1 Open the drawer completely (see figure 42).

[42] Open the  drawer

2 Remove the roll holder from the drawer (see figure 43).

[43] Removing the roll holder from the drawer

3 Remove the empty core from the roll holder while pressing the knob (see 
figure 44).

4 Slide the roll holder in the new roll of material while pressing the knob (see 
figure 44). The knob must be at the right hand side and paper must be 
positioned as shown in figure 44.
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[44] Press the knob

5 Align the roll with the appropriate lines on the roll holder while pressing the 
knob. This line has to be completely visible.

6 Place the roll holder with the material in the drawer (see figure 45).

[45] Reposition the roll

7 Feed the material between the input guide plates against the rollers.
8 Turn the rollers until the material is visible (see figure 46). Also refer to the 

sticker inside the drawer.

34"
A0 36"
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[46] Feed the material

9 If you have inserted a roll with another material or with a different width, you 
have to program the correct width and material type (refer to ‘Media type and 
size on the printer’ on page 23).
If you want to cut the paper to get a straight leading strip refer to ‘Cut media’ 
on page 26. 
Otherwise continue with the next step.

10 Close the drawer.
11 Press the On-line key.

▼ How to load roll 2

1 Open the cover to get access to roll 2 (see figure 47).

[47] Open the lower paper drawer

2 Remove the roll holder (see figure 48).
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[48] Remove the roll holder from the lower paper drawer

3 Remove the empty core from the roll holder while pressing the knob (see 
figure 44 on page 112).

4 Slide the roll holder in the roll of print material while pressing the knob (see 
figure 44 on page 112). 
It is important to have the knob at the right hand side and the paper as shown 
in figure 44.

5 Align the roll with the appropriate lines on the roll holder while you press the 
knob.
Place the roll holder with the material in the lower paper compartment (see 
figure 49).

da

[49] Reposition the roll in the lower paper drawer

6 Feed the material between the input guide plates against the rollers.Turn the 
rollers until the material is visible (see figure 50). Also refer to the sticker 
inside the drawer.
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[50] Feed the material

If you want to cut the paper to get a straight leading strip refer to ‘Cut media’ 
on page 26. 
Otherwise continue with the next step.

7 Close the lower paper compartment.
8 Press the On-line key.

How to program media settings

If you insert a new roll with another material or with a different width, set the 
new roll specifications.

The width of the material
Material Size
A0 841 mm
A1 594 mm
A2 420 mm
A3 297 mm
E 34 in
D 22 in
C 17 in
B 11 in
E+ 36 in
D+ 24 in
C+ 18 in
B+ 12 in
30 in 30 in
B1+ 700 mm
B2+ 500 mm
Note: The default is 36 inch
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The material  paper, transparent, transparent 110g, vellum, film, film 4,5, 
translucent. Set the material type according to the following table:

Material properties 
Material Weight Media Setting
Plain paper 64 g/m2(55 g/m2) Paper 64g
Plain paper 75 g/m2(110 g/m2) Paper
Biotop paper 80 g/m2 Paper 75g
Green label 80 g/m2 Paper 75g
Transparent paper 75 g/m2 Transparent 75g
Transparent paper 90/95 g/m2 (80/85 g/m2) Transparent 75g
Transparent paper 110/115 g/m2 Transparent 110 g
Translucent 60 g/m2 Translucent
Vellum 20 lbs (16 lbs) Vellum
Film 3.5 mil (4 mil) Film
Film 4.5 mil Film 4.5
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How to refill toner

If the ‘Refill toner’ message appears on the printer panel, you must refill toner 
immediately. 

Attention: Use only B5 toner.

▼ Refill toner

1 Press the On-line / Off-line key to turn the printer off-line.
2 Unscrew the knurled nut at the left hand side of the printer and open the left 

cover (see figure 51).

[51] Unscrew the knurled nut and open the cover

3 Shake the toner bottle thoroughly and open the bottle.
4 Screw in the bottle clockwise in a slanted position (see figure 52).



118 Océ TDS320 User Manual

[52] Screw in the bottle

5 Move the toner bottle to a vertical position (see figure 53).

[53] Add toner

6 Tap the toner out of the bottle.
7 When the toner bottle is empty return the bottle to the original position.
8 Unscrew the toner bottle counterclockwise.

▼ Replace the waste toner bag

9 Pull the waste toner bag from the holder and place the cap provided on the bag 
(see figure 54).

B5

B5
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[54] Replace the waste toner bag

10 Slide a new waste toner bag over the holder.
11 Close the cover and tighten the knurled nut.
12 Press the On-line / Off-line key to turn the printer on-line and to resume 

printing. 

Note: Replace the toner waste bag, every time you refill the toner.
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Clean the glass platen and the reference 
roller of the scanner

If the glass platen of the scanner is dirty or static, it should be cleaned to ensure 
top quality copies are produced. At the same time you can clean the white 
reference roller.

Attention: When you clean the reference roller, be careful not to damage the 
sensors on the scanner

▼ How to clean the glass platen and reference roller

1 Switch off the scanner.
2 Unlock the top cover by pushing the front side of the cover down and pulling 

it towards.

[55] Open the top cover of the scanner

3 Raise the cover (see figure 56 on page 121). 
4 Clean the glass platen and the white pressure platen gently with a soft cloth 

moistened with a small quantity “Cleaner A”.  
For safety information see the safety data sheet in Appendix B.
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[56] Glass platen and reference roller

5 Lower the top cover.
6 Lock the cover by pushing the front side of the cover down and pushing it back 

to the rear until you hear a click.
Note: Make sure that the cover is closed correctly, to ensure proper original 
transport.

7 Switch on the scanner.
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Chapter 8 
How to solve problems

This chapter describes the problems that can occur with the 
Océ TDS320.
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Introduction

This chapter describes problems that can occur with the Océ TDS320 and how 
to correct the problems. 

The following problems can occur on the Océ TDS320:
■ Original jams in the scanner (see page 125).
■ Paper jams in the printer (see page 127).

Stickers on parts of the system indicate which green handles, green knobs, 
green bars and covers can be lifted, pressed or opened to remove the jammed 
material.

If you clear the error, the display gives the instruction on how to continue the 
job. Refer to ‘Error messages’ on page 34 for complete information about the 
error messages on the printer operator panel.
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Original jams in scanner

If an original jams, you can stop the original with the orange Cancel key.

▼ How to remove a jammed original

1 Unlock the top cover by pushing the front side of the cover down and pull it 
towards you. (see figure 57).

[57] Open the top cover of the scanner

2 Raise the cover (see figure 58)

[58] Raise the cover of the scanner

3 Remove the original.
4 Lower the top cover.
5 Lock the cover by pushing the front side of the cover down and push it back to 

the rear until you hear a click.
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Note: Make sure that the cover is closed correctly, to make sure correct 
original move.

6 Press the Cancel key. 
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Paper jams in the printer

Paper jam in the material feed section

If a jam occurs a message appears on the operator panel. If a paper jam occurs, 
check if:
■ The roll is loaded correctly and the media is fed as indicated.
■ The correct media is used (see ‘List of available material types and sizes’ on 

page 139).
■ No scraps of material are blocking the paper path

▼ How to clear a jam in the material feed section

1 Press the On-line / Off-line key to turn the printer off-line.
2 Open the correct roll compartment.

Note: One compartment can be open at a time.
3 Lower the feed table, use the two catches on the front underneath the feed table 

(see figure 59).

[59] Lower the feed table

4 Remove the jammed material. 
5 Close the feed table.
6 Close the roll compartment.
7 Press the On-line / Off-line key to turn the printer on-line. 

Note: If you cannot clear the paper jam by opening the feed table, than open 
the fusing section (see ‘Paper jam in the fuser section’ on page 128).
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Paper jam in the fuser section

Caution: Open the fuser only to remove the paper after a media jam. 
Because of hot surfaces the operator always has to be cautious and wear 
heat-protective gloves when he removes material in the fuser section.

▼ How to clear a jam in the fuser section

1 Press the On-line / Off-line key to turn the printer off-line.
2 Loosen the screw at the left hand side of the machine and open the cover (see 

figure 60).

[60] Unscrew the knurled nut to open the cover

3 Lift the green handle (see figure 61).

[61] Lift the green handle

4 Open the fuser unit (see figure 62).
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Caution: If the printer is used, the fuser can be hot.

[62] Open the fuser section

5 Remove the jammed material.

Attention: Be careful! The toner is not fused.

6 Lift the green handle and close the fuser unit.
7 Close the left cover and tighten the screw.
8 Press the On-line / Off-line key to turn the printer on-line.

2
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Summary and tables
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The Océ TDS320 

[63] The Océ TDS320 system

1 Scanner
2 Scanner feed table
3 Scanner operating panel
4 Printer
5 Manual feed
6 Printer operating panel
7 Monitor
8 Cabinet
9 Océ Power Logic® Controller

10 Rolls
11 Integrated Receiving Tray

1 2 3 4 5

7

8

9

1011

6
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Printer operator panel

next/select

previous

on-line stop

1

2

3

56

4

1 The graphics display
2 The Previous key
3 The Next/select key
4 The Stop key
5 The Browse keys (left , 

right )
6 The On-line key
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Scanner operator panel

Alphanumeric 
display

Browse keys

Confirm
key

Strip key

Copy quantity 
display

Cancel key

+ key

Zoom key

Exposure key

- key

Start key

Media key

Extra keyOutput keyInput key

+-start cancel

stripexposure

input output extra

set file

zoom

sheet copy

leading

trailing

roll 1

roll 2

manual

media
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Product specifications Océ TDS320

The Océ TDS320 is a wide format low to medium volume print and copy 
system.

Printer
Technology Electrophotography (LED) with organic photoconductor 

(OPC) drum and closed toner system
Resolution 600 dpi
Speed 1.8 A0s p/min.
Media sources 1 roll version with manual feed

2 roll version with manual feed
COS (Compact Output Stacker):
Extended integrated stacker for up to 100 prints

Output sizes From A3 to A0 and 36”, a maximum of 15 meters long
Media types Plain, translucent, transparent, recycled, fluorescent and 

colored papers; films and vellum
Output reception Standard Integrated Receiving Tray (IRT)
Warm up time None, instant behavior
Dimensions 1352 mm (W) x 1250 mm (H) x 899mm (D) including in-

tegrated receiving tray
Weight Model with 1 roll 149 kg

Model with 2 rolls 159 kg

[64] 
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Océ Power Logic® Controller 
Platform Océ Controller with embedded Windows® XP
Memory 512 MByte RAM standard, expandable to 1024 MByte
Disk space High-speed hard disk dedicated to file spooling, and a 

high-speed hard disk dedicated to set memory offering 
1000 A0 storage capacity

File formats HP-GL, HP-GL/2, HP-RTL, TIFF 6.0, CALS type 1, 
NIRS, EDMICS (C4), CalComp 906/907/951, ASCII, 
Adobe® PostScript® 3™

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45
Network protocols TCP/IP, Novell (IPX, SPX), FTP, LPD
Cabinet An option to store the controller
User Interface GUI with a monitor, keyboard and mouse to use the ap-

plications on the controller
Adobe® Postscript® 
3™ / PDF

Enables you to print the Postscript® level 3™ files and 
Portable Document Files (PDF), optional.

Functionality Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll selection and switching
Plot manipulation: rotation, auto scaling
File spooling on the controller
Set memory: send once, process once, print many; capac-
ity to store up to 1000 A0s and create identical sets sorted 
by page or by set
Concurrent receiving / processing / printing of digital 
jobs

[65] 
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Océ Remote Logic® software
Software Application Functionality
Océ Settings Editor change system settings

[66] 

Scanner
Model Free-standing console
Technology CCD, Océ Image Logic® real-time image processing hard-

ware
Speed 3 linear meters per minute or approximately 2 A0s per 

minute
Original feed Face down, right aligned

Automatic feed off/on
Rewind original to front off/on

Originals A4 to A0 sizes and 36”, up to 15 meters.
Maximum thickness 1 mm
Exposure control Automatic background compensation, manual fine adjust-

ment.
Special modes: Lines & Text, Photo, Blueprint

Media selection Manual selection of roll 1 or 2 or manual feed.
Reproduction scale Zoom: 25% - 400% (adjustable in 1% programmable fixed 

steps)
Scan-to-file zoom: 50% - 200%

Input mode Single sheet
Set (sets processing/set collation)

Functionality Multi-copy mode: 1-99 copies (scan once, print many)
Pre-programming of next job
Programmable default settings
Standard cut, synchro cut
Scan-to-file (option)
Leading and trailing strip adjustment (remove 400 mm, add 
400 mm)

Image editing Image mirroring
Dimensions 1240 mm (W) x 1105 mm (H) x 615 mm (D)
Weight 65 Kg

[67] 

Océ Scan Logic®
Application Océ Scan Manager, integrated scanning solution, including 

Océ View Station LT
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Scan destinations 6 programmable destinations
Scan to controller
Scan to network directory
File Transfer Protocol (FTP)

Resolution 200, 300, 400 dpi
Data formats Tiff (G3, G4, uncompressed)

CALS type 1
PDF

Scan modes Single scan, batch scanning with or without checkprint
File naming Automatically generate unique file names for each scan
Check print To check your scanned file
Viewing View scans at point of scanning
Océ Image Logic® Optimum scan quality with special original modes
Ease of use STF from scanner panel, scan directly to destination
Requirements A graphical user interface
Options Océ View Station LT for editing and enhancement of 

scanned documents
Océ Batch Processor for automated editing.

Drivers and application software
Océ HDI driver For AutoCAD® 2000, 2000i, 2002, 2004, 2005, 2006
Océ Windows Printer 
driver

Windows® 2000, XP, 2003 server

Adobe® PostScript® 
Level 3™  
drivers

For Windows® 95/98/2000, NT 4.0®, XP and Macin-
tosh®

Note: Check Océ on the internet at www.oce.com for the latest drivers.

Compact output stacker
Model The transport unit that delivers copies and prints on the 

front-side of the printer.
Capacity Up to 100 sheets depending on the material.

[68] 
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List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance. 
It is therefore recommended to use only approved Océ materials in the Océ 
TDS320. 
A full list of Océ materials suited for use in the Océ TDS320, including plain 
paper, transparent paper, colored papers and various polyester films is 
available from your Océ representative.

Material types

The following material types are available for the Océ TDS320:

Material Types
Materials Weight
Plain paper 64 g/m2 (55g/m2) 
Plain paper 75 g/m2 (110g/m2)
Plain paper 80 g/m2

Biotop paper 80 g/m2

Green Label 80 g/m2

Recyonomic 60 g/m2

Translucent paper 75 g/m2

Transparent paper 90/95 g/m2(80/85g/m2)
Transparent paper 110/115 g/m2

Transparent paper 20 lbs (16 lbs)
Top label paper 60 g/m2

Vellum 3.5 mil (4 mil)
Film 4.5 mil
Polyester film 3.5 or 4.5 mil
Special Colored paper, etc.

Minimum Maximum
Width 297 mm 914 mm
Length 420 mm 15 m
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The following material sizes are available for the Océ TDS320:

500 

Attention: Avoid storing paper in rooms where temperature and humidity 
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic 
to prevent it absorbing moisture.

DIN range
Material Width [mm] Length [mm]
A3 297 420
A2 420 594
A1 594 841
A0 841 1189

8.5 inch range
Material Width [inch] Length [inch]
11 inch / B 11 17
17 inch / C 17 22
22 inch / D 22 34
34 inch / E 34 44

9 in range
Material Width [inch] Length [inch]
12 inch / B+ 12 18
18 inch / C+ 18 24
24 inch / D+ 24 36
36 inch / E+ 36 48

Other formats
Material Width Length
30 in 30 in 12 in
B1+ 700 mm 1000 mm
B1 (DIN) 707 mm 1000 mm
B2+ 500 mm 700 mm
B2 (DIN) 500 mm 707 mm
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Automatic format selection

The Océ TDS320 controller switches to the next larger format. For example 
you set the 8.5 inch range on the printer. The job you print is an A1 format. The 
printer will automatically select the 30 inch format. The next table shows 
which format the Océ TDS320 controller chooses if you print a specific format 
on a chosen range.

Automatic format selection
Paper series
DIN DIN carto 8.5 in Mixed 8.5 and 9.5 inch

DIN range
A3 X X
A2 X X
A1 X X
A0 X X
8.5 inch range
11 inch / B X X
17 inch / C X X
22 inch / D X X
34 inch / E X X
9 in range
12 inch / B+ X
18 inch / C+ X
24 inch / D+ X X
36 inch / E+ X X X X
Other formats
30 in X X
B1 carto X
B1 (DIN) X
B2 carto X
B2 (DIN) X

[69] 
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Summary of standard zoom formats

Standard zoom fixed steps for the DIN paper series [%]
Original A0 A1 A2 A3 36 in B1 B2
A0 100 71 50 35 109 84 59
A1 141 100 71 50 153 119 84
A2 200 141 100 71 218 168 119
A3 283 200 141 100 308 238 168
36 in 107 65 46 32 100 77 55
B1 119 84 59 42 129 100 71
B2 168 119 84 59 183 141 100

[70] 

Standard zoom fixed steps for the DIN carto paper 
series [%]
Original A0 A1 A2 A3 36 in B1 B2
A0 100 71 50 35 109 83 59
A1 141 100 71 50 153 118 84
A2 200 141 100 71 218 167 119
A3 283 200 141 100 308 236 168
36 in 107 65 46 32 100 77 55
B1 120 85 60 42 130 100 71
B2 168 119 84 59 183 140 100

[71] 

Standard zoom fixed steps for the 8.5 inch paper series 
[%]
Original 
[inch]

11 / B 17 / C 22 / D 24 / D+ 30 34 / E 36 / E+

11 / B 100 154 200 218 273 309 327
17 / C 65 100 129 141 176 200 212
22 / D 50 77 100 109 136 155 164
24 / D+ 46 71 92 100 125 142 150
30 37 57 73 80 100 113 120
34 / E 32 50 65 71 88 100 106
36 / E+ 31 47 61 67 83 94 100

[72] 
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Standard zoom fixed steps for the 8.5 & 9 inch mixed 
paper series [%]
Original 
[inch]

11 / B 12 / 
B+

17 / C18 / 
C+

22 / D24 / 
D+

30 34 / E36 / E+

11 / B 100 109 154 164 200 218 273 309 327
12 / B+ 92 100 142 150 183 200 250 283 300
17 / C 65 71 100 106 129 141 176 200 212
18 / C+ 61 67 94 100 122 133 167 189 200
22 / D 50 55 77 82 100 109 136 155 164
24 / D+ 46 50 71 75 92 100 125 142 150
30 37 40 57 60 73 80 100 113 120
34 / E 32 35 50 53 65 71 88 100 106
36 / E+ 31 33 47 50 61 67 83 94 100

[73] 
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Notation conventions

There are a number of notation conventions used in this manual. This 
consistent style enables you to quickly become conversant with the use of this 
manual and consequently the Océ TDS320.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered in a sequential 
way throughout this manual. Figures include pictures of product components, 
screendumps, examples, and diagrams of concepts discussed in the 
description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to prevent 
something (your copy or original, the copier or printer, data files, etc.) 
being damaged.

Caution: The information that follows ‘Caution’ is given to prevent you 
suffering personal injury. 



147

Reader’s comment sheet

Have you found this manual to be accurate? 
❏ Yes 
❏ No

Could you operate the product after reading this manual? 
❏ Yes 
❏ No

Does this manual provide enough background information? 
❏ Yes 
❏ No

Is the format of this manual convenient in size, readability and arrangement 
(page layout, chapter order, etc.)? 
❏ Yes 
❏ No

Could you find the information you were looking for? 
❏ Always 
❏ Most of the times 
❏ Sometimes 
❏ Not at all

What did you use to find the required information? 
❏ Table of contents 
❏ Index

Are you satisfied with this manual? 
❏ Yes 
❏ No

Thank you for evaluating this manual.  
If you have other comments or concerns, please explain or suggest 
improvements overleaf or on a separate sheet.
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Comments: 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------------------- 
Date:

This reader’s comment sheet is completed by:  
(If you prefer to remain unknown, please do fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V. 
For the attention of ITC User Documentation. 
P.O. Box 101, 
5900 MA Venlo 
The Netherlands

Send you comments by E-mail to: itc-userdoc@oce.nl

For the addresses of local Océ organizations see: www.oce.com
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Addresses of local Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Kornmarksvej 6
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
4330 Mülheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

 
 
 

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.
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Index

A
access   103
add a controller   93
add toner   117

replace waste toner bag   117
alphanumeric display   19
applications   84
apply   101
auto-feed   61
Automatic format selection   141
automatically view a scanned file   76
available material types and sizes   139

C
cancel key   54
cleaner A   120
clear media jam

fuser section   128
roll feed section   127

Clear set memory   32
command line parameters   90
Compact output stacker   138
compression   64
configuration report   27
connect to a controller   93
Connecting   93
connecting workstations   78
controller

start up   97
copy process

start   44
cut media   26

D
delete a scanned file   75
demo print   28
destination   62

delete   73
lock   72
unlock   73

destination properties   74
Diagnostic mode   32
display (printer)

Error messages   34
Status messages   33

Drivers   138

F
file type   62
FTP   77

G
general control buttons   103
get files   78

I
input key   39
install remote logic   85
IP address.   29

J
Japan support

destination names   72

K
key operator settings   98
keys   20

selection keys   20
stop   20
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L
load media   110

M
maintenance

glass platen   120
reference roller   120

make a scan
how to   61

manual feed   9,   51
Material

types   139
Material properties   116
menu bar   100
menu level indicator   19,   41

N
network settings   29

default gateway   29
IP address   29
subnetmask   29

networksettings
DHCP server   29

O
Océ TDS400 applications

scan manager   67
Océ TDS400 system   8
on/off switch printer   21,   43
on/off switch scanner   43
optional

Automatic 2-roll unit   11
Compact output stacker   12
Scan-to-File   12

organization   64
original guide line   44
original jam   125
output key   39

P
paper series   32

8.5 inch   32
DIN   32
DIN CARTO   32
mix 8.5/9 inch   32

Power Logic Controller   10
pre-cut copy material   51
print

configuration report   27
demo print   28
menu card printer   27

print a scanned file   74
print with oce repro desk   29
printer   9
printer keys   20
printer menu   27
printer settings

selecting language   29
set a special media indication   23
stopping print job   29

problems   124
product specifications   135

Drivers and application software   138
Power Logic controller   136
Printer   135
Remote Logic software   137
Scan Logic   137

program media settings   115
properties of a scanned file   75

R
refill toner   117
release paper   61
repro operator settings   13
resolution   62,   63
retrieve scanned files   77
rewind original   61

S
Scan jobs

Leading and trailing strip   56
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Scan Manager
destination

lock   72
local destination   70
network destination   71
web destination   72

scanner   9
scanner display   40
scanner feed table   44
scanner operating panel

keys   39
Scan-to-file

destination
ftp   72
local   70
smb   71

scan-to-file
file name   73
password   60
settings   62

select language   29
selection keys   20
set

default gateway   31
IP address   30
language   29
media type   24
media width   24
paper series   32
Subnetmask   31
time-out manual feed   25
use DHCP server   30

Set default gateway   29
set media type and size   23
set memory   32
setting dependencies   98
settings area   101
Settings Editor   11
standard cut   42
standard zoom formats   142
status bar   103
stop a copy job   54
stop key   20
Subnetmask   29
switching off

scanner   44
switching on

scanner   43

synchro cut   42
system administrator settings   98
System menu   29

enter   30

T
table view   68

file properties   68
temporary store   76
tiff subformat   64
time-out manual feed   25
top cover of the scanner   120,   125
tree structure   102
tree view   68

destinations   68
turn off

printer   22
turn off the printer   21
turn on

printer   21
Turn on the controller   22,   97
turn on the printer   21

U
undo   101
Unix   87
update area   102
Use DHCP server   29
user modes   103

V
view a scanned file   74
View error   82
view station   79
view station LT   60

see a scanned file   61

W
waste toner bag   117,   118
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width of the material   115
work on a remote system   93
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